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1 欢迎使用

感谢您购买 HP Photosmart D6100 series 打印机！使用此新款照片打印机，您
可以打印精美的照片、将照片保存到计算机并创建轻松有趣的项目（使用或不使
用计算机均可）。

本手册主要介绍如何在不连接计算机的情况下进行打印。要了解如何从计算机进
行打印，请安装打印机软件并查看电子版帮助。有关将计算机与打印机配合使用
的概述，请参阅从计算机打印。有关安装软件的信息，请参阅“快速入门手
册”。

家庭用户可以了解如何进行以下操作：

● 从打印机或计算机打印无边框照片
● 选择照片布局
● 使用 HP Photosmart 软件将彩色照片转换成黑白照片、去除红眼，或者应

用特殊效果。

本打印机附有下列文档：

● 快速入门手册：“快速入门手册”介绍了如何安装打印机和打印机软件并打
印第一张照片。

● 使用手册：“使用手册”是您正在阅读的这本手册。本手册说明了此款打印
机的基本功能，以及如何在不连接计算机的情况下使用打印机，并包含硬件
疑难排解信息。

● 屏幕帮助：HP Photosmart 屏幕帮助说明如何与计算机一起使用打印机，并
包含软件疑难排解信息。

特殊功能
新的功能和介质让您比以前更轻松地制作高质量的照片：

● 使用新的 HP 高级照片纸（在有些国家/地区称为 HP 照片纸）时，打印机中
的专用传感器会检测纸张背面的标记，然后自动选择最佳的打印设置。有关
新型纸张的详细信息，请参阅选择正确的纸张。

● HP Real Life 技术让您轻而易举地获得更好的照片。用于增强阴影中细节
的“自动消除红眼”和“适应性照明”，只是所包含的众多技术的一部分。
您可以从打印机软件浏览众多的编辑与增强选项。要了解如何在软件中查找
这些功能，请参阅 HP Real Life 技术功能。

访问 HP Photosmart 屏幕帮助
在计算机上安装了 HP Photosmart 软件后，就可以查看 HP Photosmart 屏幕帮
助：

● Windows：从“开始”菜单中，选择“程序”（在 Windows XP 中，选
择“所有程序”）> “HP 解决方案中心”，然后单击“帮助和支持”。

● Macintosh：从 Finder 的“帮助”菜单中，选择“Mac 帮助”。从“帮助
查看器”的“库”菜单中，选择“HP Photosmart Mac 帮助”。

HP Photosmart D6100 series 使用手册 5



打印机部件

打印机前部

1 顶盖：提起该顶盖可检修墨盒并清除卡纸。要提起顶盖，请握住 HP 徽标下的顶盖
部分然后向上拉。

2 出纸盒：该纸盒用于接住打印件。提起该纸盒即可使用照片纸盒。

3 主纸盒：拉出该纸盒可以打印面朝下装入普通纸、投影胶片、信封或其他介质。

4 照片纸盒：提起出纸盒，即可在照片纸盒中打印面朝下装入不超过 10 x 15 厘米
（4 x 6 英寸）的小型纸张。纸张可以带裁边或不带裁边。

5 开/关机：按此按钮可打开打印机。

6 相机端口：连接 PictBridge  数码相机、可选的 HP Bluetooth  无线打印机适配器
或 HP 直接打印相机。

打印机后部

1 电源线接口：使用此端口可连接打印机附带的电源线。

2 USB 端口：使用此端口可将打印机连接到计算机。

3 后检修门：取下此门可清除卡纸，或安装可选的“HP 自动双面打印附件”。请参
阅可选附件。
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主纸盒和出纸盒

1 纸张宽度导轨：调整此导轨，使其紧靠主纸盒中纸张的边缘。

2 出纸盒：该纸盒用于接住打印件。提起该纸盒即可使用照片纸盒。

3 出纸盒延长板：将其向外拉出展开出纸盒以接住打印件。

4 主纸盒：拉出该纸盒可装入普通纸、投影胶片、信封或其他介质以进行打印。

5 主纸盒拉杆：将其向外拉出以展开主纸盒。

6 纸张长度导板：调整此导板，使其紧靠主纸盒中纸张的末端。

照片纸盒

1 纸张宽度导轨：调整此导轨，使其紧靠照片纸盒中纸张的边缘。

2 纸张长度导板：调整此导板，使其紧靠照片纸盒中纸张的末端。
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控制面板

1 墨水量指示灯：标示墨盒缺失或墨水不足。

2 取消：取消打印作业。

3 重新开始：重新开始打印作业或走纸。

4 HP Photosmart Express：在已连接的计算机上打开 HP Photosmart Express。
5 开/关机：打开打印机电源或将其切换到省电模式。

指示灯

1 墨水量：如果任何墨盒墨水不足，则呈黄色常亮。此灯闪烁则表示存在包括墨盒缺
失、损坏或错误在内的各种问题。有关详细信息，请参阅墨盒错误。

2 重新开始：出现问题之后，此灯闪烁则表示可以按下该按钮重新开始打印作业。在
按下该按钮之前需要先更正问题。有关详细信息，请参阅疑难排解。

3 开/关机指示灯：如果已打开打印机，则该指示灯呈绿色常亮，否则该指示灯熄灭。

可选附件
打印机上可以使用一些增强其便利性的附件。这些附件的外观可能会与图示有所
不同。

要购买耗材，请访问：

● www.hpshopping.com（美国）
● www.hp.com/go/supplies（欧洲）
● www.hp.com/jp/supply_inkjet（日本）
● www.hp.com/paper（亚太地区）
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附件名称 说明

HP 自动双面打印附件

此附件可自动翻转每一页进行双面打
印。因此，您可以节省成本（双面打
印可减少纸张消耗）和时间（不需要
取出纸张又放进去在背面打印），而
且使大文档更易于管理。

此附件并非在所有国家/地区都提供。

HP Bluetooth  无线打印机适配器

1 将 Bluetooth 适配器插入前面的相
机端口

HP Bluetooth  无线打印机适配器必须
接入打印机前面的相机端口。此适配
器允许您使用 Bluetooth 无线技术从众
多启用 Bluetooth 的设备进行打印，包
括数码相机、可拍照手机和 PDA。
有关使用这些附件进行打印的详细信
息，请访问 www.hp.com/go/
bluetooth。
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2 准备打印

本节包括以下主题：

● 装入纸张
● 插入墨盒

装入纸张
了解如何为打印作业选择正确的纸张，以及如何将其放入进纸盒以备打印。

选择正确的纸张

使用 HP 高级照片纸。这种纸是专门为配合打印机墨水生成精美的照片而设计
的。

要获得可用的 HP 设计的照片纸列表，或是要购买耗材，请访问：

● www.hpshopping.com（美国）
● www.hpshopping.ca（加拿大）
● www.hp.com/eur/hpoptions（欧洲）
● www.hp.com（所有其他国家/地区）

打印机的默认设置为在 HP 高级照片纸上打印最佳质量的照片。如果要在其他类
型的纸张上打印，请确保在打印对话框中更改纸张类型。有关详细信息，请参
阅设置打印首选项。

装入纸张提示

● 打印面朝下装入纸张。
● 您可以在各种尺寸的纸张上打印照片和文档，从 8 x 13 厘米（3 x 5 英寸）

到 22 x 61 厘米（8.5 x 24 英寸）。10 x 15 厘米（4 x 6 英寸）的照片纸分
为带或不带裁边这两种。

● 在装入纸张前，请拉出主纸盒并向外滑动纸张宽度导轨和长度导板为纸张留
出空间。装入纸张后，调节导轨和导板使其紧靠纸张的边缘，同时使纸张保
持平整。装完纸张后，将主纸盒推回原位。

● 在一个纸盒中，每次只能装入同一类型和尺寸的纸张。
● 装入纸张后，请展开出纸盒延伸架以接住打印页。

在主纸盒中放入纸张

任何支持的照片或普通纸介质

1. 展开主纸盒。
2. 将纸张宽度导轨和长度导板滑至其最外侧。
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1 纸张宽度导轨

2 纸张长度导板

3. 打印面朝下装入纸张。检查纸叠高度是否超过纸张长度导板的顶部。
4. 向内调整纸张宽度导轨和长度导板直至其停在纸张的边缘。
5. 推入主纸盒，直至其停住不动。

1 将主纸盒一直向里推

在照片纸盒中放入纸张

不超过 10 x 15 厘米（4 x 6 英寸）带或不带裁边的照片纸、Hagaki 卡、A6 卡、
L 尺寸卡

1. 抬起出纸盒。
2. 向外拉进纸盒直至其停住。
3. 调整纸张宽度导轨和长度导板以便为纸张留出空间。
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1 出纸盒

2 纸张宽度导轨

3 纸张长度导板

4. 将纸张打印面朝下装入照片纸盒中，最多 20 张。如果使用带裁边的纸张，
请在放入纸张时让裁边朝外。

5. 向内调整纸张宽度导轨和长度导板直至其停在纸张的边缘。

1 纸张宽度导轨

2 纸张长度导板

6. 推入照片纸盒。
7. 放下出纸盒。

插入墨盒
首次安装和使用 HP Photosmart 打印机时，请确保安装打印机随附的墨盒。这
些墨盒中的墨水配方独特，可与打印头组件中的墨水混合使用。

购买替换墨盒

购买替换墨盒时，请参考本手册封底列出的墨盒编号。墨盒编号会因国家/地区
而异。
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注意 如果您已使用过几次打印机，并且已安装 HP Photosmart 打印机软
件，您也可以在打印机软件中找到墨盒编号。Windows 用户：右键单击
Windows 任务栏中的“HP Digital Imaging Monitor”图标，然后选
择“启动/显示 HP 解决方案中心”。选择“设置”、“打印设置”，然
后选择“打印机工具箱”。单击“估计墨水量”选项卡，然后单击“墨盒
详细信息”。要订购墨盒，请单击“在线购物”。Mac 用户：在 Dock 中
点按“HP Photosmart Studio”。在 HP Photosmart Studio 任务栏中，
点按“设备”。从“信息和设置”弹出菜单中，选择“维护打印机”，然
后点按“启动实用程序”。在“配置设置”列表中，点按“耗材信息”。

墨盒提示

HP Vivera 墨水提供逼真的照片效果和出色的防褪色功能，生成的色彩鲜明而且
更为持久。HP Vivera 墨水配方独特，并且经受了质量、纯度和防褪色等方面的
科学检验。

为获得最佳打印效果，HP 建议您使用原装 HP 墨盒。原装 HP 墨盒是专门为 HP
打印机设计的，并且经过严格测试，可帮助您随时轻松获得卓越的打印效果。

注意 HP 无法担保非 HP 墨水的质量和可靠性。由于使用非 HP 墨水导
致的打印机故障或损坏不在保修范围内。

墨盒

1 请勿将异物插入这些孔中

小心 防止墨水渗漏或溢出：运送打印机时让墨盒保持在安装位置，并避
免让用过的墨盒留在打印机外过长时间。

墨盒保修信息

HP 墨盒保修条款适用于在其专用 HP 打印设备上使用的产品。该保修条款不适
用于经重新灌注、改装、翻新、使用不当或恶意损坏的 HP 墨水产品。

在保修期之内，只要 HP 墨水未用完而且没有过保修期的产品均适用于保修条
款。以 YYYY/MM/DD（年/月/日）格式表示的保修截止日期可以在产品上找
到，如图所示：

第 2 章
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有关“HP 有限保修声明”的副本，请参阅 HP 保修条款。

装入或更换墨盒

1. 确保电源已打开，然后提起顶盖。

2. 按住墨盒插槽下方的灰色突块，以松开打印机内的灰色卡销，然后提起卡
销。
墨盒区采用了颜色编码以便参照。抬起相应颜色下方的卡销以插入或更换墨
盒。墨盒的颜色从左到右分别为黑色、黄色、浅青色、青色、浅品红色及品
红色。

1 黑色墨盒的卡销

2 彩色墨盒区

3. 如果要更换墨盒，请将墨盒朝外拉，使其脱离墨盒槽。

回收旧墨盒。HP 喷墨耗材回收计划覆盖许多国家/地区，免费为您回收用过
的墨盒。有关详细信息，请访问 www.hp.com/hpinfo/globalcitizenship/
environment/recycle/inkjet.html。
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4. 从包装盒中取出新墨盒，然后握住其手柄，将墨盒滑入空插槽中。
确保插入墨盒的插槽上的图标形状和颜色与新墨盒上的一致。插入墨盒时，
铜色触点应该面向打印机。

注意 首次安装和使用打印机时，请确保安装打印机随附的墨盒。这
些墨盒中的墨水配方独特，可与打印头组件中的墨水混合使用。

5. 向下按压灰色卡销直至其卡住。

6. 对每个需要更换的墨盒重复步骤 2 至 5。
必须安装所有的六个墨盒。如果缺少一个墨盒，打印机将无法工作。

7. 合上顶盖。
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3 在不使用计算机的情况下打印照片

HP Photosmart D6100 series 打印机甚至可以在不打开计算机的情况下打印照
片。当参考“快速入门手册”中的说明安装完打印机之后，您可以连接
PictBridge 相机并使用相机菜单打印照片。照片可以来自于相机存储器，也可以
来自于相机中的存储卡。

有关详细信息，请参阅从数码相机打印照片。

打印照片
您可在不使用计算机的情况下以两种方式打印照片：

● 将 PictBridge 数码相机连接到打印机前面的相机端口
● 安装可选的 HP Bluetooth  无线打印机适配器，然后利用 Bluetooth 无线技

术从数码相机打印

从数码相机打印照片

您可以使用 USB 电缆将 PictBridge 数码相机直接连接到打印机的相机端口来打
印照片。如果数码相机具备 Bluetooth 无线技术，则可以将可选的 HP
Bluetooth  无线打印机适配器插入打印机，然后以无线方式将照片发送到打印
机。

从数码相机打印时，打印机将使用已在相机上选择的设置。有关详细信息，请参
阅相机随附的文档。

从下列设备打印照片… 执行下列步骤

具有 Bluetooth 无线技术的
数码相机

如果数码相机具有 Bluetooth
无线技术，则可以购买可选
的 HP Bluetooth  无线打印
机适配器，并利用 Bluetooth
无线连接从相机打印。

您还可从其他具有 Bluetooth
无线技术的设备（如 PDA 和
可拍照手机）进行打印。有
关详细信息，请参阅连接到
其他设备和 Bluetooth 适配器
随附的文档。

1. 将纸张放入照片纸盒。
2. 将 HP Bluetooth  无线打印机适配器插入打

印机前面的相机端口。
当适配器准备接收数据时，适配器上的指示
灯会闪烁。

3. 按照数码相机随附文档中的说明将照片发送
到打印机。

具有 PictBridge 技术的数码
相机

1. 打开 PictBridge 数码相机并选择要打印的照
片。

2. 将纸张放入照片纸盒。
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从下列设备打印照片… 执行下列步骤

3. 确保相机处于 PictBridge 模式，然后用相机
随附的 USB 电缆将它连接到打印机前面的
相机端口。

4. 按照相机上的屏幕说明操作。
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4 连接

您可以使用此打印机保持与其他设备的连接，并与他人保持联系。

连接到其他设备
该打印机可以通过多种方法连接到计算机或其他设备。不同的连接类型可以完成
不同的工作。

连接类型及所需准备 用途...

USB
● 一条长度不超过 3 米（10 英尺）

的通用串行总线 (USB) 2.0 全速兼
容电缆。有关使用 USB 电缆连接
打印机的说明，请参阅“快速入门
手册”。

● 一台可以访问 Internet 的计算机
（以使用 HP Photosmart 共享）。

● 从计算机打印到打印机。请参阅从
计算机打印。

● 通过 HP Photosmart 共享共享照
片。

● 从 HP Photosmart 直接打印数码
相机直接打印到打印机。有关详细
信息，请参阅从数码相机打印照片
和相机文档。

PictBridge

PictBridge 标志

PictBridge 兼容型数码相机和 USB 电
缆。

将相机连接到打印机前方的相机端口。

从 PictBridge 兼容型数码相机直接打
印到打印机。

有关详细信息，请参阅从数码相机打
印照片和相机文档。

Bluetooth
可选的 HP Bluetooth 无线打印机适配
器。

如果打印机带有或者您单独购买了此
附件，请参阅随附的文档和屏幕帮助
以获取相关说明。

从具有 Bluetooth 无线技术的任何设备
（例如数码相机、可拍照手机或 PDA）
打印到打印机。

如果您通过相机端口将可选的 HP
Bluetooth 无线打印机适配器连接到打
印机，请确保已根据需要设置了
Bluetooth 打印机菜单选项。
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将照片保存到计算机
如果您在计算机与打印机之间建立了 USB 连接，则可以将照片从连接到打印机
相机端口的数码相机保存到计算机。

如果使用 Windows 计算机：

1. 将数码相机连接到打印机的相机端口。
2. 按下打印机上的 HP Photosmart Express 按钮。
3. 在计算机上的 HP Photosmart Express 中单击“保存”按钮。
4. 按照屏幕说明将照片从已连接的相机保存到计算机。

如果使用 Macintosh：
1. 将数码相机连接到打印机的相机端口。
2. 等待默认的图像管理应用程序（例如 iPhoto）启动并读取相机上的内容。
3. 点按“导入”将相机上的照片保存到 Macintosh。

通过 HP Photosmart 共享连接
使用 HP Photosmart 共享，通过电子邮件、在线相册或在线照片冲印服务与亲
友共享照片。您必须通过 USB 电缆将打印机连接到计算机，该计算机必须可以
访问 Internet 并且已安装了全部 HP 软件。如果要使用“共享”功能，但没有安
装或配置需要的全部软件，则会出现一条信息，提示您完成所需步骤。

使用“共享”(USB) 功能发送照片（Windows 用户）：

1. 将数码相机连接到打印机的相机端口。
2. 按下打印机上的 HP Photosmart Express 按钮。
3. 在计算机上的 HP Photosmart Express 中单击“共享”按钮。
4. 按照计算机上的说明与他人共享选择的照片。

使用“共享”(USB) 功能发送照片（Mac 用户）

1. 打开“HP Photosmart Studio”，然后选择要共享的照片。有关
HP Photosmart Studio 的详细信息，请参阅 HP Photosmart Premier
(Windows)。

2. 在 HP Photosmart Studio 任务栏中，点按“共享”。
3. 点按“继续”，然后按照计算机上的说明与他人共享选择的照片。

有关使用 HP Photosmart 共享的详细信息，请参阅软件的屏幕帮助。
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5 从计算机打印

要从计算机打印，必须安装打印机软件。软件安装过程中，在您的计算机上会安
装 HP Photosmart Premier（Windows 完全安装用户）、HP Photosmart
Essential（Windows 快速安装用户）或 HP Photosmart Studio (Mac)，您可以
组织、共享、编辑并打印照片。

有关安装软件的详细信息，请参阅“快速入门手册”。定期更新软件以确保您拥
有最新的功能和改进；有关说明，请参阅更新软件。

要处理照片，您需要将照片传输到与打印机连接的计算机。请参阅将照片保存到
计算机。

注意 Windows 用户：HP Photosmart Premier 只能在处理器速度不低
于 Intel  Pentium  III 的计算机上使用。

使用打印机软件中的创意选项
通读这些提示以了解如何打开和使用 HP Photosmart Premier (Windows)、
HP Photosmart Essential (Windows)、HP Photosmart Studio (Mac) 和 HP
Photosmart 共享。

HP Photosmart Premier (Windows)
HP Photosmart Premier 是一个易于使用的软件程序，除了基本的照片编辑和打
印外，它还为您提供一切需要的功能使您在处理照片时获得无穷乐趣。您也可以
通过该软件使用 HP Photosmart 共享以便轻松共享照片。HP Photosmart
Premier 只适用于 Windows 用户。

打开 HP Photosmart Premier（Windows 用户）

➔ 双击桌面上的“HP Photosmart Premier”图标。如果需要帮助，请参阅
HP Photosmart Premier 中的软件帮助。

浏览 HP Photosmart Premier 的众多功能：

● 查看 — 以多种尺寸和方式查看照片。轻松组织和管理照片。
● 编辑 — 裁剪照片和修正有红眼的照片。自动调整和增强不同尺寸和多种布

局的照片。
● 打印 — 以不同尺寸和多种布局打印照片。
● 共享 — 使用 HP Photosmart 共享可以无需大容量附件即可给亲友发送照

片，这是一种更好的电子邮件方式。
● 创建 — 轻松创建相册页、卡片、日历、全景照片、CD 标签，等等。
● 备份 — 备份照片副本以进行存放和保存。

HP Photosmart Essential (Windows)
HP Photosmart Essential 是一个易于使用的软件程序，它为您提供基本的照片
编辑和打印功能。您也可以通过该软件使用 HP Photosmart 共享以便轻松共享
照片。HP Photosmart Essential 只适用于 Windows 用户。
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打开 HP Photosmart Essential（Windows 用户）

➔ 双击桌面上的“HP Photosmart Essential”图标。如果需要帮助，请参阅
HP Photosmart Essential 中的软件帮助。

浏览 HP Photosmart Essential 的众多功能：

● 查看 — 以多种尺寸和方式查看照片。轻松组织和管理照片。
● 编辑 — 裁剪照片和修正有红眼的照片。自动调整和增强照片使它们更臻完

美。
● 打印 — 打印不同尺寸和多种布局的照片。
● 共享 — 使用 HP Photosmart 共享可以无需大容量附件即可给亲友发送照

片，这是一种更好的电子邮件方式。

HP Photosmart Studio (Mac)
➔ 点按 Dock 中的“HP Photosmart Studio”图标。

从 HP Photosmart Studio 访问 HP Photosmart Mac 软件，并浏览该软件的众多
功能：

● 导入 - 从 HP 数码相机导入照片或视频。
● 查看和管理 - 查看、组织和管理照片及视频。
● 编辑 - 调整和增强图像。
● 幻灯片演示 - 创建照片的在线幻灯片。
● 全景 - 从多幅图像创建单幅全景图像。
● 创建 - 创建相册页、卡片、标签、海报、条幅等。
● 打印 - 以标准尺寸或索引页格式打印照片或视频帧。
● 共享 - 无需要大量的附件即可将照片发送给亲友。
● 订购 - 在线订购打印件和礼品。

HP Photosmart 共享

HP Photosmart 共享可以在不使用大量电子邮件附件的情况下将照片发送给亲
友。有关详细信息，请参阅通过 HP Photosmart 共享连接以及 HP Photosmart
Premier、HP Photosmart Essential 或 HP Photosmart Mac 帮助。

打开 HP Photosmart 共享（Windows 用户）

➔ 在 HP Photosmart Premier 或 HP Photosmart Essential 中单击“HP
Photosmart 共享”选项卡。

打开 HP Photosmart 共享（Mac 用户）

➔ 在 HP Photosmart Studio 中，选择要共享的照片，然后点按工具栏中
的“共享”按钮。

设置打印首选项
打印首选项已有默认设置，但可以根据需要进行更改。从计算机打印时可以设置
特定作业的打印设置。如果您在打印前更改设置，则这些更改只影响当前的打印
作业。在有些 Windows 软件程序中，您需要在“打印”对话框中单击“属
性”或“首选项”以访问高级打印功能。有关打印首选项的详细信息，请参阅电
子版帮助。
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访问打印首选项（Windows 用户）

1. 通常可以从“文件”菜单选择“打印”来打开“打印”对话框。
2. 更改“打印”对话框各选项卡中的打印首选项，或者单击“属性”或“首选

项”以访问其他打印首选项。

访问打印首选项（Mac 用户）

1. 通常可以从“文件”菜单选择“打印”来打开“打印”对话框。
2. 通过在“份数和页数”下拉菜单中选择要更改的打印选项来更改“打印”对

话框中的打印首选项。

有关更改打印首选项的详细信息，请参阅电子版帮助。

打开电子版帮助

Windows 用户：

● 在键盘上按 F1。
● 要获得字段级的帮助，请单击“打印”对话框中右上角的“?”。

Mac 用户：

1. 从“Finder”中，选择“帮助” > “Mac 帮助”。
2. 从“库”菜单选择“HP Photosmart Mac 帮助”，然后在“HP Photosmart

Mac 帮助”列表中选择打印机名称。

HP Real Life 技术功能
浏览 HP Real Life 技术软件功能中的众多照片编辑和增强选项。这些功能（例
如自动消除红眼和适应性照明）可以让您轻松打印高质量照片。

共有三个可用选项：

● “基本”设置可以增强图像，并提高低分辨率图像（例如，从 Internet 下载
的图像）的质量和清晰度。

● 使用“完整”设置来修补曝光不足、曝光过度、含有暗区、红眼或褪色的照
片。

● 使用“关闭”设置在软件程序中手动编辑图像，例如，HP Photosmart 软
件。

访问 Real Life 技术功能（Windows 用户）

1. 通常可以从“文件”菜单选择“打印”来打开“打印”对话框。
2. 单击“纸张/质量”选项卡，然后单击“Real Life 数字摄影”按钮 - 或 - 单

击“属性”或“首选项”按钮，单击“功能”选项卡，然后从“Real Life 数
字摄影”区域的“照片修补”下拉菜单中选择“基本”（默认）、“完
全”或“关闭”。

访问 Real Life 技术功能（Mac 用户）

1. 通常可以从“文件”菜单选择“打印”来打开“打印”对话框。
2. 从“份数和页数”下拉菜单中选择“Real Life 数字摄影”。
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6 保养与维护

本打印机很少需要维护。遵循本章中的各项指示，可延长打印机及打印耗材的使
用寿命，并确保您始终能够打印出高质量的照片。

● 清洁和维护打印机
● 更新软件
● 打印机与墨盒的存放与运输
● 维护照片纸质量

清洁和维护打印机
使用本节所述的简易方法清洁并有效维护打印机和墨盒。

清洁打印机外部

1. 关闭打印机，然后从打印机后面断开电源线。
2. 用蘸有少量清水的软布擦拭打印机的外部。

小心 请勿使用任何清洁液，家用清洁剂和洗涤剂会损坏打印机的表面涂
层；请勿清洁打印机内部，防止液体进入打印机内部；请勿润滑支撑打印
头滑动的金属杆，打印头前后移动时发出声响是正常现象。

校准打印机

当自检报告的任何颜色块中出现条纹或白线时，请按照以下步骤操作。

如果校准打印机后仍然存在打印质量问题，请尝试按照保养与维护所述的步骤清
洁打印头。如果在校准和清洁后打印质量问题仍然存在，请联系 HP 客户支持。

如果使用 Windows 计算机：

1. 在主纸盒中放入未用过的 Letter 或 A4 普通白纸。
2. 从 Windows “开始”菜单中选择“HP” > “HP 解决方案中心”。
3. 单击“设置” > “打印设置” > “打印机工具箱”。
4. 单击“校准打印头”。
5. 按照屏幕说明操作。

如果使用 Macintosh：
1. 在主纸盒中放入未用过的 Letter 或 A4 普通白纸。
2. 点按 Dock 中的“HP 设备管理器”。
3. 从“信息和设置”弹出菜单中，选择“维护打印机”。
4. 点按“启动实用程序”。
5. 在“HP 打印机实用程序”窗口的“配置设置”区域，点按“校准”。

打印样本页

可以通过打印样本页来检测打印机的照片打印质量，并确保纸张已正确装入。
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如果使用 Windows 计算机：

1. 将纸张放入主纸盒。使用普通纸以节约照片纸。
2. 从 Windows “开始”菜单中选择“HP” > “HP 解决方案中心”。
3. 单击“设置” > “打印设置” > “打印机工具箱”。
4. 单击“打印样本页”，并按照屏幕说明操作。

如果使用 Macintosh：
1. 将纸张放入主纸盒。使用普通纸以节约照片纸。
2. 点按 Dock 中的“HP 设备管理器”。
3. 从“信息和设置”弹出菜单中，选择“维护打印机”。
4. 点按“启动实用程序”。
5. 在“HP 打印机实用程序”窗口的“配置设置”区域，点按“样本页”，然

后点按“打印样本页”。

自动清洁打印头

如果在打印的照片或自检报告的颜色块中发现白色线条或条纹，请按照此程序清
洁打印头。请在必要时再清洁打印头，否则会浪费墨水并缩短打印头上墨水喷嘴
的使用寿命。

如果使用 Windows 计算机：

1. 在主纸盒中放入未用过的 Letter 或 A4 普通白纸。
2. 从 Windows “开始”菜单中选择“HP” > “HP 解决方案中心”。
3. 单击“设置” > “打印设置” > “打印机工具箱”。
4. 单击“清洁打印头”，然后按照屏幕说明操作。

如果使用 Macintosh：
1. 在主纸盒中放入未用过的 Letter 或 A4 普通白纸。
2. 点按 Dock 中的“HP 设备管理器”。
3. 从“信息和设置”弹出菜单中，选择“维护打印机”。
4. 点按“启动实用程序”。
5. 在“HP 打印机实用程序”窗口的“配置设置”区域，点按“清洁”，然后

在窗口的右侧再次点按“清洁”。

如果在清洁打印头后打印质量仍然不佳，请尝试按照校准打印机所述的步骤校准
打印机。如果在清洁和校准后仍然存在打印质量问题，请与 HP 支持联系。

手动清洁墨盒触点

如果计算机屏幕上显示一则信息，说明墨盒缺失或损坏，请清洁墨盒铜色触点。

清洁墨盒触点前，请取出墨盒并检查是否有异物遮挡墨盒触点或墨盒槽，然后装
回墨盒。如果继续显示墨盒缺失或损坏信息，请清洁墨盒触点。如果在清洁墨盒
触点后仍然显示此信息，则需要更换墨盒。取出有问题的墨盒，查看底部的保修
截止日期，日期以 YYYY/MMM/DD（年/月/日）格式表示。如果在保修期之内，
请与 HP 支持联系以更换墨盒。
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清洁墨盒触点：

1. 准备好清洁触点所需的以下物品：

– 蒸馏水、过滤水或瓶装水（自来水中可能含有会损坏墨盒的杂质）

小心 请勿使用滚筒清洁器或酒精来清洁墨盒触点。这些物品会
损坏墨盒或 HP Photosmart。

– 干燥的泡沫橡胶拭子、无绒布，或不会散开或留下纤维的任何柔软材
料。

2. 打开打印机顶盖。
3. 按住墨盒插槽下方的灰色突块，以松开打印机内的灰色卡销，然后提起卡

销。

小心 请勿同时取出多个墨盒。一次仅取出和清洁一个墨盒。不要将
墨盒放在打印机外面超过 30 分钟。

4. 用水稍微润湿拭子或软布，并挤掉多余的水分。
5. 握住墨盒手柄，然后用拭子或软布只轻轻擦拭铜色触点。

1 只轻轻擦拭铜色触点

6. 将墨盒放回空的插槽，然后向下按压灰色卡销直到其卡住。
7. 如有必要，请重复此步骤清洁其他墨盒。
8. 合上顶盖。

小心 供墨装置可能会增压。将异物插入供墨装置会导致墨水飞溅到物品
或人身上。

打印自检报告

如果遇到打印问题，请打印自检报告。此报告可以帮助您诊断打印问题，而且，
如果需要联系 HP 客户支持，它也可以提供有价值的信息。您也可以用此报告来
检查墨盒中剩余的估计墨水量百分比。

如果使用 Windows 计算机：

1. 将纸张放入主纸盒。使用普通纸以节约照片纸。
2. 从 Windows “开始”菜单中选择“HP” > “HP 解决方案中心”。
3. 单击“设置” > “打印设置” > “打印机工具箱”。
4. 单击“打印诊断页”，并按照屏幕说明操作。
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如果使用 Macintosh：
1. 在主纸盒中放入未用过的 Letter 或 A4 普通白纸。
2. 点按 Dock 中的“HP 设备管理器”。
3. 从“信息和设置”弹出菜单中，选择“维护打印机”。
4. 点按“启动实用程序”。
5. 在“HP 打印机实用程序”窗口的“配置设置”区域，点按“测试”，然后

在窗口的右侧点按“打印测试页”。

HP Photosmart 会打印包含下列信息的双页式自检报告：

● 产品信息：包括型号、序列号和其他产品信息。
● 版本信息：包括固件版本号，并说明是否安装了 HP 双面打印附件（双面打

印器）。
● 供墨系统信息：显示所安装的每个墨盒的估计墨水量、状态、安装日期，以

及保质期。
● 打印头组件信息：包含要致电 HP 客户支持时可能用于诊断的信息。
● 打印头参数：包含要致电 HP 客户支持时可能用于诊断的信息。
● 打印质量图案：显示六个颜色块，分别代表已安装的六个墨盒。当颜色块中

出现条纹，或缺失颜色块时，请按照保养与维护所述的步骤清洁打印头。如
果清洁打印头后颜色块仍然显示有打印质量问题，请按照校准打印机所述的
步骤校准打印机。如果在清洁和校准之后，颜色块仍然显示有打印质量问
题，请与 HP 支持联系。

● 历史记录：包含要致电 HP 客户支持时可能用于诊断的信息。

自检报告

更新软件
定期下载最新的打印机软件更新，以确保软件具有最新的功能和改进。您可以访
问 www.hp.com/support 或使用“HP 软件更新”来下载打印机软件更新。

注意 您从 HP 网站下载的软件更新不能更新 HP Photosmart Premier 软
件。
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下载软件 (Windows)

注意 在使用“HP 软件更新”之前，确保已连接到 Internet。

1. 从 Windows “开始”菜单中，选择“程序”（在 Windows XP 中，选
择“所有程序”）> “Hewlett-Packard” > “HP 软件更新”。将打开“HP
软件更新”窗口。

2. 单击“开始检查”。“HP 软件更新”将从 HP 网站搜索打印机软件的更新
程序。如果计算机没有安装最新版本的打印机软件，“HP 软件更新”窗口
中会显示软件更新程序。

注意 如果计算机安装了最新版本的打印机软件，“HP 软件更
新”窗口中显示以下信息：“此时没有系统可用的更新”。

3. 如果有软件更新，请单击软件更新旁的复选框将其选中。
4. 单击安装。
5. 按照屏幕说明完成安装。

下载软件 (Mac)

注意 在使用 HP Photosmart 更新工具之前，确保已连接到 Internet。

1. 从 Finder 中，选择“转到” > “应用程序”。
2. 选择“Hewlett-Packard” > “Photosmart” > “HP Photosmart 更新工

具”。
3. 按照屏幕说明检查软件更新。

如果正在使用防火墙，您需要在更新工具中输入代理服务器信息。

打印机与墨盒的存放与运输
为了保护打印机和墨盒，在不使用时应妥善存放。

存放和搬运打印机

打印机在设计上可经受长期或短期的闲置。将打印机存放在室内避光并且温度适
中的地方。

小心 防止墨水渗漏或溢出：搬运或存放打印机时不要让它侧边着地，并
且不要取出已安装的墨盒。

存放和搬运墨盒

搬运或存放打印机时，请始终将正在使用的墨盒留在打印机中以防止墨水变干。

小心 1 防止墨水流失或溢出：存放或搬运打印机时不要取出已安装的墨
盒，并避免让用过的墨盒留在打印机外过长时间。

小心 2 在拔下电源线之前，请确保打印机已完成关机过程。此过程可使
打印机正确安置打印头。
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按照该提示进行操作有助于维护 HP 墨盒并确保稳定的打印质量：

将所有不使用的墨盒保存在其原始密封包装中，直到需要时再取出来。请在室温
下存放墨盒 (15-35 °C 或 59-95 °F)。

维护照片纸质量
要获得照片纸的最佳打印效果，请遵循本节的指导原则。

存放照片纸

● 将照片纸存放在原始包装中，或放入可重新封装的塑料袋中。
● 将包好的照片纸存放在平坦、凉爽、干燥的平面上。
● 将不使用的照片纸放回塑料袋中，将纸张留在打印机内或暴露于外界环境中

会导致纸张卷曲。

使用照片纸

● 请始终拿取照片纸的边缘以免留下指纹。
● 如果照片纸边缘卷曲，请将纸张放在塑料储存袋中并轻轻地朝卷曲的相反方

向弯曲，直到纸张恢复平整。
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7 疑难排解

HP Photosmart 打印机在设计上具有可靠易用的特点，本章回答了有关使用打印
机以及不用计算机进行打印的常见问题，其中包含有关下列主题的信息：

● 打印机硬件问题
● 打印问题
● 错误信息

有关其他疑难排解信息，请参阅：

● 软件安装疑难排解：打印机随附的“快速入门”手册。
● 打印机软件以及从计算机进行打印的疑难排解：HP Photosmart 打印机屏幕

帮助。有关查看屏幕上的“HP Photosmart 打印机帮助”的信息，请参阅欢
迎使用。

打印机硬件问题
在联系 HP 支持之前，请阅读本节的疑难排解提示或访问网站 www.hp.com/
support 的在线支持服务。

注意 如果要用 USB 电缆将打印机连接到计算机，HP 建议使用长度不超
过 3 米（10 英寸）的 2.0 高速兼容电缆。

开/关机指示灯闪烁，但打印机不打印

解决方法 打印机正在处理信息；请等待它完成。

打印机已插上电源，但无法打开

解决方法

● 打印机可能消耗的功率太多。拔下打印机电源线。等待大约 10 秒钟，
然后插上电源线，开启打印机。

● 打印机所插入的接线板电源可能已经关闭。打开接线板开关，然后打开
打印机电源。

● 电源线可能损坏。确保电源线上的绿色指示灯亮着。

打开打印机时发出噪音，或打印机一段时间不使用后发出噪音

解决方法 打印机长时间不用（约 2 周）、供电中断然后恢复或更换完墨盒
时，可能发出噪音。这是正常现象。打印机正在执行自动维护程序以确保输
出最佳质量的打印件。
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打印机上的所有指示灯闪烁

解决方法 打印机出现硬件错误并可能需要维修。拔下打印机电源线。等
待 10 秒钟，然后再插上电源线。打开打印机电源。如果指示灯仍然闪烁，
请访问 www.hp.com/support 或与 HP 支持联系以寻求帮助。

打印问题
在联系 HP 支持之前，请阅读本节的疑难排解提示或访问网站 www.hp.com/
support 的在线支持服务。

当从数码相机打印时，打印机无法打印无边框照片

解决方法 确保照片纸盒中已放入照片纸。打印机从数码相机打印时只能使
用照片纸盒（不是主纸盒）中的介质。

打印速度非常慢

解决方法 您可能遇到了以下一种情况：1) 正在打印含有高分辨率图形或照
片的 PDF 文件或项目，或 2) 为打印输出选择了最高的分辨率。打印含有图
形或照片的大型复杂项目要比文本文档慢，尤其是分辨率较高时。

纸张未从主纸盒正确送入打印机

解决方法

● 纸盒中可能装入了太多的纸张。取出一些纸张并尝试重新打印。
● 主纸盒可能未完全推入到位。将主纸盒完全推入到位。
● 可能没有正确调整纸张导轨。确保纸张宽度导轨和长度导板紧靠纸张边

缘，同时保持纸张平整。
● 两张或多张纸可能粘在一起。从主纸盒取出纸张，呈扇形展开纸叠以将

纸张分开，然后重新装入纸张并尝试再次打印。
● 如果纸张褶皱或弯曲，尝试使用其他纸张。
● 纸张可能太薄或太厚。为了获得最佳效果，请使用 HP 喷墨纸。有关详

细信息，请参阅选择正确的纸张。

打印出的纸张从出纸盒中掉落

解决方法 打印时始终展开出纸盒延伸架。

不能打印使用照片纸盒的打印作业

解决方法 照片纸盒可能未正确安装到打印机上。提起出纸盒并确认照片纸
盒已完全推入，然后放下出纸盒。按重新开始。
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打印出的纸张有褶皱或卷曲

解决方法 打印项目使用的墨水量比平时多。从计算机打印项目，并使用打
印机软件降低墨水饱和度。有关详细信息，请参阅 HP Photosmart 屏幕帮
助。

打印的文档是斜的或者不居中

解决方法

● 纸张可能没有正确装入。重新装入纸张，确保纸张在主纸盒中方向正
确，并且纸张宽度导轨和长度导板紧靠纸张边缘。有关装入纸张的说
明，请参阅装入纸张提示。

● 如果使用双面打印附件，请尝试将其取下然后重新打印。
● 打印机可能需要校准。有关详细信息，请参阅校准打印机。

打印的颜色不尽人意

解决方法

● 打印机可能需要校准。有关详细信息，请参阅校准打印机。
● 打印头可能需要清洁。有关详细信息，请参阅保养与维护。

打印时打印机不出纸或发生卡纸

解决方法

● 打印机可能需要维护。如果打印机与计算机相连，请查看计算机屏幕上
的说明。

● 电源可能已关闭，或者连接松动。确保电源已打开且电源线连接牢固。
● 主纸盒或照片纸盒中可能缺纸。检查纸张是否装入正确。有关装入纸张

的说明，请参阅装入纸张提示。
● 如果在打印时卡纸，请尝试以下操作：

– 关闭打印机电源，然后拔下电源插头。清除打印机中任何阻塞送纸
通道的纸张。取下后检修门。轻轻地从打印机中取出被卡住的纸
张，然后重新装上后检修门。如果无法从打印机后面取出所有卡
纸，请尝试打开位于顶盖内部的卡纸门，取出卡在打印机中间的纸
张。有关清除卡纸的两个位置的图示，请参阅纸张错误。清除卡纸
后，插上打印机电源线然后打开电源，尝试重新打印。

– 如果打印标签，请确保标签在通过打印机时没有从标签纸上脱落。

打印机输出空白页

解决方法

● 可能已经开始打印，然后又取消了打印作业。
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如果在开始打印前取消打印作业，打印机可能已经装入纸张并准备打
印。下次打印时，打印机会在开始新的打印作业前先退出空白页。

● 可能将具有大量数据的打印作业发送到打印机。
等待打印机维护打印头后，再继续打印。

无法使用默认打印设置打印照片

解决方法 您可能已经更改了照片的打印设置。应用于相机上个别照片的打
印设置将取代默认打印设置。通过取消选择相机上的单个照片，可以停止使
用应用于该照片的所有打印设置。有关详细信息，请参阅相机随附的文档。

准备打印时打印机退出纸张

解决方法 日光直射可能会影响自动纸张传感器的正常工作。将打印机移到
避光处。

打印质量差

解决方法

● 使用打印机专用照片纸。为了获得最佳效果，请使用选择正确的纸张中
所建议的纸张。

● 可能打印到纸张错误的一面上。确保打印面朝下装入纸张。
● 您可能在数码相机上选择了低分辨率设置。缩小图像尺寸并尝试重新打

印。为了在以后获得更好的效果，请为数码相机设置较高的照片分辨
率。

● 打印头可能出现问题。请尝试以下操作：

– 运行打印头自动清洁程序。有关详细信息，请参阅保养与维护。
– 校准打印机。有关详细信息，请参阅校准打印机。
– 如果在尝试所有上述解决方法后打印质量问题仍然存在，请联系 HP

支持。

未正确打印照片

解决方法

● 您可能没有正确地装入照片纸。打印面朝下装入照片纸。
● 照片纸可能没有正确送入打印机。请尝试以下操作：

– 检查是否出现卡纸。有关详细信息，请参阅纸张错误。
– 将照片纸尽可能深地插入照片纸盒。
– 一次装入一张照片纸。

未打印在数码相机中标记要打印的照片

解决方法 有些数码相机可以让您在相机的内部存储器和存储卡上标记要打
印的照片。如果在内部存储器中标记了照片，然后又将照片从内部存储器转
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移到存储卡上，标记不会随之转移。请将照片从数码相机内部存储器转移到
存储卡后，再标记要打印的照片。

将相机连接到打印机之后没有响应

解决方法 请尝试以下操作：

● 确保相机已连接到打印机前面的相机端口。后面的 USB 端口不支持数
码相机。

● 确保该相机是设置为 PictBridge 模式的 PictBridge 数码相机或者 HP 直
接打印相机。 打印机只支持这两种类型的相机。

● 检查相机电池。如有必要请更换。
● 重新启动相机。

错误信息
在联系 HP 支持之前，请阅读本节的疑难排解提示或访问网站 www.hp.com/
support 的在线支持服务。

如果打印机已连接到计算机，计算机屏幕上可能会出现下列类型的错误信息：

● 纸张错误
● 墨盒错误
● 存储卡或相机错误
● 计算机打印错误

如果打印机未与计算机连接，请检查指示灯：

开/关机 重新开
始

墨水指示
器

注解

呈绿色常
亮

闪烁 熄灭 指示灯的这种组合经常表示与纸张相关的打
印机问题，例如，卡纸、缺纸或不送纸。有
关详细信息，请参阅纸张错误。也可能是连
接问题，例如打印过程中数码相机的连接被
断开。有关详细信息，请参阅计算机以及连
接打印错误。

闪烁 闪烁 熄灭 托架停止不动。有关详细信息，请参阅错误
信息：打印托架被卡住。

呈绿色常
亮

关闭 闪烁 出现墨盒问题，例如，墨盒已空、损坏或不
正确。有关详细信息，请参阅墨盒错误。

闪烁 闪烁 闪烁 出现硬件问题。有关详细信息，请参阅打印
机上的所有指示灯闪烁。

纸张错误

在联系 HP 支持之前，请阅读本节的疑难排解提示或访问网站 www.hp.com/
support 的在线支持服务。
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错误信息：卡纸。

解决方法 关闭打印机电源，然后拔下电源插头。清除打印机中任何阻塞纸
张通道的纸张。取下后检修门。轻轻地从打印机中取出卡纸，然后重新装上
后检修门。按下重新开始以继续打印。

1 取下后检修门以清除卡纸。

如果无法从打印机后面取出所有卡纸，请尝试打开位于顶盖内部的卡纸门，
取出卡在打印机中间的纸张。

1 打开卡纸门清除卡在打印机中间的纸张。

重新插上打印机的电源插头，然后打开打印机电源。

错误信息：打印机缺纸。

解决方法 装入纸张，然后按重新开始以再次打印。有关装入纸张的说明，
请参阅装入纸张提示。

错误信息：不支持的介质尺寸。

解决方法 装入纸盒中的纸张尺寸不适用于本打印机。按重新开始，然后装
入在尺寸上支持的纸张。有关支持的纸张尺寸列表，请参阅打印机技术规
格。
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错误信息：自动纸张传感器故障。

解决方法 自动纸张传感器被挡住或已损坏。将打印机移到避光处，然后
按重新开始并尝试重新打印。如果这样做无效，请访问 www.hp.com/
support 或与 HP 支持联系。

墨盒错误

在联系 HP 支持之前，请阅读本节的疑难排解提示或访问网站 www.hp.com/
support 的在线支持服务。

错误信息：墨盒不正确。

解决方法 首次安装和使用 HP Photosmart 时，请确保安装打印机随附的
墨盒。这些墨盒中的墨水配方独特，可与打印头组件中的墨水混合使用。

要解决此问题，请使用 HP Photosmart 随附的墨盒更换有问题的墨盒。

指定墨盒在设备初始化后无法使用。将该墨盒更换为 HP Photosmart 的专
用墨盒。用于此打印机的墨盒编号位于本印刷手册的封底上。

有关更换墨盒的详细信息，请参阅插入墨盒。

错误信息：立即更换墨盒。

解决方法 指定的墨盒墨水不足。

使用打印头组件中剩余的墨水继续打印只能维持很短的一段时间。更换指定
的墨盒或按重新开始继续。

有关更换墨盒的详细信息，请参阅插入墨盒。

错误信息：墨盒已空。

解决方法 用新墨盒更换指定的墨盒。

● 如果黑色墨盒已空，则可以按照屏幕说明继续使用其他彩色墨盒进行打
印。

● 如果彩色墨盒已空，则可以按照屏幕说明继续使用黑色墨盒进行打印。

根据您的打印作业状态，您可以按重新开始以继续。如果 HP Photosmart
正在处理打印作业，请按“取消”并重新开始打印作业。

注意 文本和照片质量会与使用所有墨盒时的打印效果不一样。 如果
不尽快更换空墨盒，所有打印将会停止。

有关更换墨盒的详细信息，请参阅插入墨盒。

错误信息：无法打印。

解决方法 指定的墨盒墨水已用完。

立即更换指定的墨盒以便继续打印。
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更换指定的墨盒之后，HP Photosmart 才可以继续打印。此前所有打印将会
停止。

有关更换墨盒的详细信息，请参阅插入墨盒。

错误信息：墨盒问题。

解决方法 指定的墨盒缺失或损坏。

立即更换指定的墨盒以便继续打印。如果 HP Photosmart 未缺失墨盒，则
可能需要清洁墨盒触点。

有关更换墨盒的详细信息，请参阅插入墨盒。有关清洁墨盒触点的详细信
息，请参阅保养与维护。

如果 HP Photosmart 未缺失任何墨盒，而在清洁墨盒触点后仍然显示此信
息，则可能需要更换墨盒。取出有问题的墨盒，查看底部的保修截止日期，
日期以 YYYY/MMM/DD（年/月/日）格式表示。如果在保修期之内，请与
HP 支持联系以更换墨盒。

错误信息：墨水已接近保质期。- 或 - 墨盒已过期。

解决方法 每个墨盒都有保质期。设定保质期的目的是为了保护打印系统并
确保墨水质量。当显示墨水过期信息时，请取下并更换墨盒，然后关闭该信
息。也可以按照计算机屏幕上的说明操作，不更换墨盒而继续打印。HP 建
议更换过期墨盒。HP 无法担保过期墨盒的质量或可靠性。由于使用过期墨
水而导致的设备维修不在保修范围之内。

有关更换墨盒的详细信息，请参阅插入墨盒。

错误信息：非 HP 墨盒。

解决方法 更换指定的墨盒或按重新开始以继续。

HP 建议您使用原装 HP 墨盒。原装 HP 墨盒是专门为 HP 打印机而设计并
经过测试，可帮助您随时轻松获得卓越的打印效果。

注意 HP 无法担保非 HP 墨水的质量和可靠性。由于使用非 HP 墨水
导致的打印机故障或损坏不在保修范围之内。

如果您确信所购买的是原装 HP 墨盒，请访问：

www.hp.com/go/anticounterfeit

错误信息：原来的 HP 墨水已用完。

解决方法 更换指定的墨盒或按重新开始以继续。

HP 建议您使用原装 HP 墨盒。原装 HP 墨盒是专门为 HP 打印机所设计并
经过科学测试，可帮助您随时轻松获得卓越的打印效果。
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注意 HP 无法担保非 HP 墨水的质量和可靠性。由于使用非 HP 墨水
导致的打印机故障或损坏不在保修范围之内。

如果您确信所购买的是原装 HP 墨盒，请访问：

www.hp.com/go/anticounterfeit

错误信息：打印托架被卡住。

解决方法 清除卡住打印头组件的所有物件。

清理打印头组件

1. 打开顶盖，然后打开卡纸门。

1 打开卡纸门以清理打印头组件。

2. 清除卡住打印头组件的所有物件，包括纸张和任何包装材料。
3. 关闭打印机电源，然后再将它打开。
4. 关闭卡纸门和顶盖。

错误信息：供墨系统故障。

解决方法 打印头组件或供墨系统出现故障，HP Photosmart 无法再进行打
印。

关闭打印机，然后拔下电源线。等待 10 秒钟，然后再插上电源线。如果该
操作无法清除该错误信息，请联系 HP 支持。

存储卡或相机错误

在联系 HP 支持之前，请阅读本节的疑难排解提示或访问网站 www.hp.com/
support 的在线支持服务。
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错误信息：相机不兼容或未处于 PictBridge 模式。请参考“使用手册”。

解决方法 HP Photosmart 只支持处于 PictBridge 模式的数码相机或 HP 直
接打印相机。如果是 PictBridge 相机，请确保其处于 PictBridge 模式。有关
详细信息，请参阅相机随附的文档。

错误信息：无法打印照片。

解决方法 为打印作业指定的照片中，有 10 张以上可能已损坏、缺失或者
是不支持的文件类型。有关支持的文件类型的信息，请参阅打印机技术规
格。

● 使用数码相机而不是存储卡，将照片保存至计算机。
● 将文件保存至计算机，并从计算机打印。

错误信息：相机选择 (DPOF) 文件出错。

解决方法 打印机无法读取 DPOF 文件，因为存储卡上的数据已损坏或出
现错误。用相机重新选择照片。

错误信息：有些相机选定的照片不在存储卡上。

解决方法 有些相机选定的照片缺失或被删除。请尝试以下操作：

● 确认您没有不小心将该照片从存储卡上删除。
● 使用数码相机重新选择照片。

计算机以及连接打印错误

在与 HP 支持联系之前，请阅读本节的疑难排解提示或访问网站 www.hp.com/
support 的在线支持服务。

错误信息：打印机内存已满。作业已被取消。请按“OK”。

解决方法 打印机在打印照片时遇到问题。请尝试以下操作：

● 要清空打印机内存，请关闭打印机，然后再重新打开。
● 一次打印少量照片。
● 将照片保存至计算机，并从计算机打印。
● 使用存储卡读取器将文件保存到计算机并从计算机打印。

错误信息：HP Photosmart 未连接！

解决方法 打印机无法与计算机进行正常通信。可能是打印机软件尚未启动
或者电缆松动。确保 USB 电缆牢固地连接在计算机上和打印机背面的 USB
端口上。如果电缆连接牢固，确认打印机软件已经安装。
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错误信息：相机无响应。检查相机连接、电池，或者重新打开相机。请参考“使用手
册”。

解决方法 打印作业将会取消。将 USB 电缆重新连接到相机和计算机，然
后重新发送打印作业。
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8 HP 支持

注意 HP 支持服务的名称会因国家/地区而异。

如果遇到问题，请按以下步骤操作：

1. 查阅打印机随附的文档。
2. 如果使用文档中的信息还不能解决问题，请访问 www.hp.com/support 以执

行下列操作：

– 访问在线支持页面
– 向 HP 发送电子邮件寻求问题答案
– 通过在线聊天与 HP 技术人员联系
– 检查软件更新

支持选项和可用性将因产品、国家/地区以及语言而有所不同。
3. 如果使用屏幕帮助或 HP 网站无法解决问题，请联系您所在国家/地区的 HP

支持。要获得国家/地区电话号码的列表，请参阅 HP 电话支持。

HP 电话支持
打印机在保修期内时，可以获得免费的电话支持。有关详细信息，请参阅包装盒
内的保修声明，或访问 www.hp.com/suppor 查看免费支持的期限。

免费电话支持期满后，您需要支付额外费用以获得 HP 帮助。请与 HP 经销商联
系，或拨打您所在国家/地区的支持电话以了解支持选项。

要获取 HP 电话支持，请拨打您所在地区的支持电话号码。您需要支付电话公司
的标准电话费。

北美： 致电 1-800-474-6836 (1-800–HP-INVENT)。美国电话支持分英语和西
班牙语两种，提供每周 7 天、每天 24 小时的全天候服务（支持天数或小时数如
有变更，恕不另行通知）。保修期内，此项服务是免费的。超过保修期，可能需
要收费。

西欧：奥地利、比利时、丹麦、西班牙、法国、德国、爱尔兰、意大利、荷兰、
挪威、葡萄牙、芬兰、瑞典、瑞士以及英国的客户应访问 www.hp.com/
support 以获取各自国家/地区的电话支持号码。

其他国家/地区：参阅本手册封面中的支持电话号码列表。

致电

请在计算机和打印机旁致电 HP 支持。准备提供以下信息：

● 打印机型号（位于打印机前部）
● 打印机序列号（位于打印机底部）
● 计算机操作系统
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● 打印机软件版本：

– Windows PC：要查看打印机软件版本，请右键单击 Windows 任务栏
中的“HP Digital Imaging Monitor”图标并选择“关于”。

– Macintosh：要查看打印机软件版本，请使用“打印”对话框。
● 计算机显示器上出现的信息
● 以下问题的解答：

– 您在电话中提及的情况以前发生过吗？可否重现这种情况？
– 在发生此情况前后，您是否在计算机上安装了任何新的硬件或软件？

退回 HP 维修服务部门（仅限北美）
HP 会安排将您的产品运送到 HP 主要维修中心。我们将支付往返的运输费用和
修理费。此项服务在硬件保修期内是免费的。

其他保修选项
付费后可以享用打印机延长服务计划。请访问 www.hp.com/support，选择您的
国家/地区和语言，然后浏览有关延长服务计划的服务和保修信息。
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A 技术规格

本节列出了安装 HP Photosmart 打印机软件所需的最低系统需求，并提供了所选打印机
的技术规格。

有关打印机技术规格和系统需求的完整列表，请参阅 HP Photosmart 屏幕帮助。有关查
看 HP Photosmart 屏幕帮助的信息，请参阅欢迎使用。

系统需求

组件 Windows PC 最低需求 Macintosh 最低需求

操作系统 Microsoft  Windows 98、
2000 Professional、Me、
XP Home 和 XP
Professional

Mac  OS X 10.3、10.4 和
更新版本

处理器 Intel  Pentium  II（或同性
能处理器）或更快

G3 或更快

RAM 64 MB（建议使用 128 MB） Mac OS X 10.3、10.4 和更
新版本：128 MB

可用磁盘空间 500 MB 150 MB

视频显示器 800 x 600，16 位或更高 800 x 600，16 位或更高

CD-ROM 驱动器 4x 4x

连接 USB：Microsoft Windows
98、2000 Professional、
Me、XP Home 和 XP
Professional
PictBridge：使用前方相机
端口

Bluetooth：使用可选的
HP Bluetooth 无线适配器

USB： 前面和后面的端口
（Mac OS X 10.3、10.4 和
更新版本）

PictBridge：使用前方相机
端口

Bluetooth：使用可选的
HP Bluetooth 无线适配器

浏览器 Microsoft Internet Explorer
5.5 或更高版本

—

打印机技术规格

类别 技术规格

图像文件格式 JPEG 基线

TIFF 24 位 RGB 未压缩隔行扫描

TIFF 24 位 YCbCr 未压缩隔行扫描

TIFF 24 位 RGB Packbits 隔行扫描
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类别 技术规格

TIFF 8 位灰色未压缩/Packbits
TIFF 8 位彩色未压缩/Packbits
TIFF 1 位未压缩/Packbits/1D Huffman

视频文件格式 Motion-JPEG AVI
Motion-JPEG QuickTime
MPEG-1

介质规格 建议的最大长度：61 厘米（24 英寸）

建议的最大纸张厚度：292 微米（11.5 密耳）

建议的最大信封厚度：673 微米（26.5 密耳）

支持的介质尺寸 从计算机打印时支持的尺寸

7.6 x 12.7 厘米至 22 x 61 厘米（3 x 5 英寸至
8.5 x 24 英寸）

从连接到相机端口的数码相机打印时支持的尺寸

公制：10 x 15 厘米（带或不带裁边）、A6；英制：
3.5 x 5 英寸、4 x 6 英寸（带或不带裁边）；其他：
Hagaki

支持的介质类型 纸张（普通纸、喷墨纸、照片纸和全景照片纸）

信封

投影胶片

标签纸

卡片：索引卡、贺卡、Hagaki 卡、A6、L 尺寸

烫印转印纸

Avery C6611 和 C6612 照片不干胶贴纸：10 x 15 厘
米（4 x 6 英寸），每页具有 16 个矩形或椭圆形不干
胶标贴。

HP CD/DVD 标贴纸（并非在所有国家/地区都能买
到）

纸盒 – 支持的介质尺寸 主纸盒

8 x 13 厘米至 22 x 61 厘米（3 x 5 英寸至
8.5 x 24 英寸）

照片纸盒

大至 10 x 15 厘米（4 x 6 英寸），带或不带裁边

出纸盒

所有支持的主纸盒和照片纸盒尺寸

纸盒容量 主纸盒

100 张普通纸

14 个信封

20 - 40 张卡片（视厚度而定）

附录 A
（续）
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类别 技术规格

30 张标签纸

25 张投影胶片、烫印转印纸或照片纸

10 张照片纸

照片纸盒

20 张照片纸

50 张普通纸

10 张卡片或信封

25 张标签或烫印转印纸

工作环境 建议的温度范围：15–30 °C (59-86 °F)
最大温度范围：5–40 °C (41-104 °F)
储存温度范围：-40–60 °C (-40-140 °F)
建议的湿度范围：20–80% RH
最大湿度范围：10–80% RH

物理规格 高度：17.29 厘米（6.81 英寸）

宽度：46.25 厘米（18.21 英寸）

长度：38.73 厘米（15.25 英寸）

重量：7.37 千克（16.2 磅）

耗电量 打印，最大：59 W
闲置：10-12 W
关闭：少于 1 W

电源型号 HP 部件号：0957-2105

电源要求 100–240 VAC (± 10%), 50–60 Hz (± 3 Hz)

墨盒 HP 黄色墨盒

HP 青色墨盒

HP 淡青色墨盒

HP 品红色墨盒

HP 淡品红色墨盒

HP 黑色墨盒

注意 可用于本打印机的墨盒编号位于本印刷
手册的封底上。如果您已经使用过几次本打印
机，则可在打印机软件中找到墨盒编号。有关
详细信息，请参阅插入墨盒。

（续）
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类别 技术规格

打印速度（最大） 黑色打印：每分钟 32 页
彩色打印：每分钟 31 页
照片：14 秒打印一张 10 x 15 厘米（4 x 6 英寸）照
片

USB 支持 Microsoft Windows 98、2000 Professional、Me、
XP Home 和 XP Professional
Mac OS X 10.3、10.4 和更新版本

HP 建议使用长度不超过 3 米（10 英尺）的 USB 2.0
全速兼容电缆。

附录 A
（续）
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B HP 保修条款
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1 Welcome
Thank you for purchasing an HP Photosmart D6100 series printer! With this new photo
printer you can print beautiful photos, save photos to a computer, and create fun and
easy projects with or without a computer.
This guide primarily explains how to print without connecting a computer. To learn how
to print from a computer, install the printer software and view the electronic Help. For an
overview of using a computer and the printer together, see Printing from a computer. For
information about installing the software, see the Quick Start Guide.
Home users can learn how to:
● Print borderless photos from the printer or from a computer
● Choose a photo layout
● Convert a color photo to black and white, remove red eye, or apply special effects

by using the HP Photosmart software
The printer comes with the following documentation:
● Quick Start Guide: The Quick Start Guide explains how to set up the printer, install

the printer software, and print your first photo.
● User Guide: The User Guide is the book you are reading. This guide describes the

basic features of the printer, explains how to use the printer without connecting a
computer, and contains hardware troubleshooting information.

● Onscreen help: The onscreen HP Photosmart help describes how to use the printer
with a computer and contains software troubleshooting information.

Special features
New features and media make it easier than ever to produce high-quality photos:
● When you use the new HP Advanced Photo Paper (also called HP Photo Paper in

some countries/regions), special sensors in the printer detect a mark on the back of
the paper and automatically select the optimal print settings. For more information
about this new paper, see Choose the right paper.

● HP Real Life technologies make it easy for you to get better photos. Automatic red
eye removal and adaptive lighting to enhance detail in shadows are just a few of the
many technologies included. You can explore the many editing and enhancing
options from the printer software. To learn how to find them in the software, see
HP Real Life technologies features.

Accessing the onscreen HP Photosmart help
After you have installed the HP Photosmart software on a computer, you can view the
onscreen HP Photosmart help:
● Windows: From the Start menu, select Programs (in Windows XP, select All

Programs) > HP Solution Center, and then click Help and Support.
● Macintosh: From the Finder Help menu, choose Mac Help. From the Help

Viewer Library menu, choose HP Photosmart Mac Help.
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Printer parts

Front of printer
1 Top cover: Lift this cover to access the ink cartridges and to clear paper jams. To lift the cover,

grasp the top cover below the HP logo and pull upward.
2 Output tray: Use this tray to catch your printouts. Lift this tray to access the photo tray.
3 Main tray: Pull out this tray and load paper, transparencies, envelopes, or other media with

the side to be printed facing down.
4 Photo tray: Lift the output tray and load small-size paper up to 10 x 15 cm (4 x 6 inch) into

the photo tray for printing with the side to be printed facing down. The paper may be tabbed
or untabbed.

5 On: Press this button to turn on the printer.
6 Camera port: Connect a PictBridge™ digital camera, the optional HP Bluetooth® wireless

printer adapter, or an HP direct-printing camera.

Back of printer
1 Power cord connection: Use this port to connect the power cord included with the printer.
2 USB port: Use this port to connect the printer to a computer.
3 Rear access door: Remove this door to clear paper jams or to install the optional

HP Automatic Two-sided Printing Accessory. See Optional accessories.

Chapter 1
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Main and Output trays
1 Paper-width guide: Adjust this guide to fit close to the edge of the paper in the main tray.
2 Output tray: Use this tray to catch your printouts. Lift this tray to access the photo tray.
3 Output tray extender: Pull towards you to extend the output tray to catch your printouts.
4 Main tray: Pull out this tray and load plain paper, transparencies, envelopes, or other media

for printing.
5 Main tray grip: Pull toward you to extend the main tray.
6 Paper-length guide: Adjust this guide to fit close to the end of the paper in the main tray.

Photo tray
1 Paper-width guide: Adjust this guide to fit close to the edge of the paper in the photo tray.
2 Paper-length guide: Adjust this guide to fit close to the end of the paper in the photo tray.
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Control panel
1 Ink indicator: Indicates missing ink cartridges or low ink.
2 Cancel: Cancel a print job.
3 Resume: Resume a print job or advance paper.
4 HP Photosmart Express: Open HP Photosmart Express on a connected computer.
5 On: Turn on the printer or put it into power save mode.

Indicator lights
1 Ink indicator: Solid amber if any ink cartridge is low on ink. Blinks to indicate various problems

including a missing, damaged, or incorrect cartridge. For more information, see Ink cartridge
errors.

2 Resume: Blinks to indicate that you can press to resume a print job after a problem has
occurred. You need to fix the problem before pressing. For more information, see
Troubleshooting.

3 On light: Solid green if the printer is on, otherwise it is off.

Optional accessories
There are several optional accessories available for the printer that enhance its
convenience. The appearance of the accessories may vary from what is shown.
To purchase supplies, go to:
● www.hpshopping.com (U.S.)
● www.hp.com/go/supplies (Europe)
● www.hp.com/jp/supply_inkjet (Japan)
● www.hp.com/paper (Asia/Pacific)

Chapter 1
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Accessory name Description

HP Automatic Two-sided Printing
Accessory

This accessory automatically flips each
page to print on both sides. You will save
money (two-sided printing reduces paper
consumption) and time (no need to
remove the paper and reinsert it to print on
the back), plus you will make bulky
documents more manageable.
This accessory may not be available in all
countries/regions.

HP Bluetooth® wireless printer
adapter
1 Insert the Bluetooth adapter into the

front camera port

The HP Bluetooth® wireless printer
adapter goes into the camera port on the
front of the printer. This adapter lets you
use Bluetooth wireless technology for
printing from many Bluetooth-enabled
devices, including digital cameras,
camera phones, and PDAs.
For more information on printing with this
accessory, go to www.hp.com/go/
bluetooth.
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2 Get ready to print
This section includes the following topics:
● Load paper
● Insert ink cartridges

Load paper
Learn how to choose the right paper for your print job and how to load it into the input
tray for printing.

Choose the right paper
Use HP Advanced Photo Paper. It is especially designed to work with the inks in your
printer to create beautiful photos.
For a list of available HP-designed photo paper, or to purchase supplies, go to:
● www.hpshopping.com (U.S.)
● www.hpshopping.ca (Canada)
● www.hp.com/eur/hpoptions (Europe)
● www.hp.com (All other countries/regions)
The printer is set by default to print the best quality photos on HP Advanced Photo Paper.
If you print on a different type of paper, be sure to change the paper type in the print
dialog box. For more information, see Set print preferences.

Paper loading tips
● Load paper with the side to be printed facing down.
● You can print photos and documents on a wide variety of paper sizes, from 8 x 13 cm

(3 x 5 inch) up to 22 x 61 cm (8.5 x 24 inch). The 10 x 15 cm (4 x 6 inch) photo paper
is available with and without tabs.

● Before loading paper, pull the out main paper tray and slide out the paper-width and
paper-length guides to make room for the paper. After loading paper, adjust the
guides to fit close to the edges of the paper without bending the paper. When finished
loading paper, push the main tray back in all the way.

● Load only one type and size of paper at a time in the same tray.
● After loading paper, extend the output tray extension to catch your printed pages.

Load the main tray
Any supported photo or plain paper media
1. Extend the main tray.
2. Slide the paper-width and paper-length guides to their outermost positions.

HP Photosmart D6100 series User Guide 11

http://www.hpshopping.com
http://www.hpshopping.ca
http://www.hp.com/eur/hpoptions
http://www.hp.com


1 Paper-width guide
2 Paper-length guide

3. Load paper with the side to be printed facing down. Check that the stack of paper
is no higher than the top of the paper-length guide.

4. Adjust the paper-width and paper-length guides inward until they stop at the edges
of the paper.

5. Push the main tray in until it stops.

1 Push in the main tray all the way

Load the photo tray
Photo paper up to 10 x 15 cm (4 x 6 inch) with or without tabs, Hagaki cards, A6 cards,
L-size cards
1. Lift the output tray.
2. Pull the photo tray out until it stops.
3. Adjust the paper-width and paper-length guides to make room for the paper.
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1 Output tray
2 Paper-width guide
3 Paper-length guide

4. Load up to 20 sheets of paper into the photo tray with the print side down. If you are
using tabbed paper, insert the paper so the tab is closer to you.

5. Adjust the paper-width and paper-length guides inward until they stop at the edges
of the paper.

1 Paper-width guide
2 Paper-length guide

6. Push in the photo tray.
7. Lower the output tray.

Insert ink cartridges
The first time you set up and use your HP Photosmart printer, make sure to install the
ink cartridges that were shipped with your printer. The ink in these ink cartridges is
specially formulated to mix with the ink in the print head assembly.

Purchasing replacement ink cartridges
When purchasing replacement cartridges, refer to the cartridge numbers that appear on
the back cover of this guide. These cartridge numbers may vary by country/region.
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Note If you have already used the printer several times and you have installed
the HP Photosmart printer software, you can also find the cartridge numbers in
the printer software. Windows users: Right-click the HP Digital Imaging Monitor
icon in the Windows taskbar, and select Launch/Show HP Solution Center.
Select Settings, then Print Settings, and then Printer Toolbox. Click the
Estimated Ink Levels tab, and then click Ink Cartridge Information. To order
ink cartridges, click Shop Online. Mac users: Click HP Photosmart Studio in
the Dock. In the HP Photosmart Studio toolbar, click Devices. From the
Information and Settings pop-up menu, choose Maintain Printer and then
click Launch Utility. In the Configuration Settings list, click Supply Info.

Ink cartridge tips
HP Vivera Inks deliver true-to-life photo quality and exceptional fade resistance resulting
in vivid colors that last for generations! HP Vivera Inks are specially-formulated and
scientifically tested for quality, purity and fade resistance.
For optimum printing results, HP recommends using only genuine HP ink cartridges.
Genuine HP ink cartridges are designed and tested with HP printers to help you easily
produce great results, time after time.

Note HP cannot guarantee the quality or reliability of non-HP ink. Printer service
or repairs required as a result of printer failure or damage attributable to the use
of non-HP ink will not be covered under warranty.

Ink cartridge
1 Do not insert objects into these holes

Caution To prevent ink loss or spillage: leave the ink cartridges installed while
transporting the printer, and avoid leaving used ink cartridge(s) out of the printer
for extended lengths of time.

Ink cartridge warranty information
The HP ink cartridge(s) warranty is applicable when the product is used in its designated
HP printing device. This warranty does not cover HP ink products that have been refilled,
remanufactured, refurbished, misused, or tampered with.
During the warranty period the product is covered as long as the HP ink is not depleted
and the end of warranty date has not been reached. The end of warranty date, in YYYY/
MM/DD format, may be found on the product as indicated:
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For a copy of the HP Limited Warranty Statement, see HP Warranty.

Inserting or replacing the ink cartridges
1. Make sure the power is on, then lift the top cover.

2. Squeeze the gray tab below an ink cartridge slot to release the gray latch inside the
printer, then lift the latch.
The ink cartridge areas are color-coded for easy reference. Lift the latch below the
appropriate color to insert or replace a cartridge. From left to right, the ink cartridges
are black, yellow, light cyan, cyan, light magenta, and magenta.

1 Ink cartridge latch for the black ink cartridge
2 Ink cartridge area for the color ink cartridges

3. If you are replacing a cartridge, remove the old cartridge by pulling it toward you out
of its slot.

Recycle the old cartridge. The HP Inkjet Supplies Recycling Program is available in
many countries/regions and lets you recycle used ink cartridges free of charge. For
more information, go to www.hp.com/hpinfo/globalcitizenship/environment/recycle/
inkjet.html.
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4. Remove the new ink cartridge from its packaging, and while holding it by the handle,
slide the ink cartridge into the empty slot.
Make sure you insert the ink cartridge into the slot that has the same shaped icon
and color as the new cartridge. The copper-colored contacts should be facing the
printer as the ink cartridge is inserted.

Note The first time you set up and use the printer, make sure to install the
ink cartridges that were shipped with your printer. The ink in these ink
cartridges is specially formulated to mix with the ink in the print head
assembly.

5. Press down on the gray latch until it clicks into place.

6. Repeat steps 2 through 5 for each ink cartridge you are replacing.
You must install all six cartridges. The printer will not work if an ink cartridge is
missing.

7. Close the top cover.
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3 Printing photos without a
computer
The HP Photosmart D6100 series printer lets you print photos without even turning on
the computer. Once you've set up the printer using the instructions in the Quick Start
Guide, you can connect a PictBridge camera and print your photos using the menu on
the camera. The photos can be in the camera memory or on a memory card in the
camera.
For more information, see Print photos from a digital camera.

Printing photos
You can print photos without a computer in a couple of ways:
● Connect a PictBridge digital camera to the camera port on the front of the printer
● Install the optional HP Bluetooth® wireless printer adapter and print from a digital

camera with Bluetooth wireless technology

Print photos from a digital camera
You can print photos by connecting a PictBridge digital camera directly to the camera
port of the printer with a USB cable. If you have a digital camera with Bluetooth wireless
technology, you can insert the optional HP Bluetooth® wireless printer adapter in the
printer and send photos to the printer wirelessly.
When you print from a digital camera, the printer uses the settings that you selected on
the camera. For more information, see the documentation that came with the camera.
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To print photos from a… Follow these steps

Digital camera with Bluetooth
wireless technology
If you have a digital camera with
Bluetooth wireless technology,
you can purchase the optional
HP Bluetooth® wireless printer
adapter and print from a camera
using a Bluetooth wireless
connection.
You can also print from other
devices with Bluetooth wireless
technology, such as PDAs and
camera phones. For more
information, see Connecting to
other devices and the
documentation that came with
the Bluetooth adapter.

1. Load paper in the photo tray.
2. Insert the HP Bluetooth® wireless printer

adapter into the camera port on the front of the
printer.
The light on the adapter flashes when the
adapter is ready to receive data.

3. Follow the instructions in the documentation
that came with the digital camera to send photos
to the printer.

Digital camera with
PictBridge technology

1. Turn on the PictBridge digital camera and select
the photos you want to print.

2. Load paper in the photo tray.
3. Make sure the camera is in PictBridge mode,

then connect it to the camera port on the front
of the printer using the USB cable that came
with the camera.

4. Follow the onscreen instructions on the camera.
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4 Getting connected
Use the printer to stay connected to other devices and people.

Connecting to other devices
This printer offers several ways of connecting to computers or other devices. Each
connection type lets you do different things.

Connection type and what you need This lets you...

USB
● A Universal Serial Bus (USB) 2.0 full-

speed compliant cable 3 meters
(10 feet) or less in length. For
instructions about connecting the
printer with a USB cable, see the
Quick Start Guide.

● A computer with Internet access (to
use HP Photosmart Share).

● Print from a computer to the printer.
See Printing from a computer.

● Share photos through HP Photosmart
Share.

● Print directly from an HP Photosmart
direct-printing digital camera to the
printer. For more information, see
Print photos from a digital camera and
the camera documentation.

PictBridge

The PictBridge symbol

A PictBridge-compatible digital camera
and a USB cable.
Connect the camera to the camera port on
the front of the printer.

Print directly from a PictBridge-compatible
digital camera to the printer.
For more information, see Print photos
from a digital camera and the camera
documentation.

Bluetooth
The optional HP Bluetooth wireless printer
adapter.
If the printer came with this accessory or
you have purchased it separately, see the
accompanying documentation and the
onscreen Help for instructions.

Print from any device with Bluetooth
wireless technology—such as a digital
camera, a camera phone, or a PDA—to
the printer.
If you connect the optional HP Bluetooth
wireless printer adapter to the printer
through the camera port, be sure to set the
Bluetooth printer menu options as
needed.
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Saving photos to a computer
You can save photos to a computer from a digital camera connected to the camera port
of the printer, if you set up a USB connection between the computer and the printer.

If you are using a Windows computer:
1. Connect a digital camera to the camera port of the printer.
2. Press the HP Photosmart Express button on the printer.
3. Click the Save button in HP Photosmart Express on the computer.
4. Follow the onscreen instructions to save photos from the connected camera to the

computer.

If you are using a Macintosh:
1. Connect a digital camera to the camera port of the printer.
2. Wait for the default image management application, such as iPhoto, to start and read

the contents of the camera.
3. Click Import to save the photos on the camera to your Macintosh.

Connecting through HP Photosmart Share
Use HP Photosmart Share to share photos with friends and relatives using e-mail, online
albums, or an online photo finishing service. Your printer must be connected through a
USB cable to a computer with Internet access and have all the HP software installed. If
you try to use Share and do not have all the required software installed or configured, a
message prompts you through the required steps.

Use Share (USB) to send photos (Windows users):
1. Connect a digital camera to the camera port of the printer.
2. Press the HP Photosmart Express button on the printer.
3. Click the Share button in HP Photosmart Express on the computer.
4. Follow the instructions on your computer to share the selected photos with others.

Use Share (USB) to send photos (Mac users)
1. Open HP Photosmart Studio and select photos to share. For information about

HP Photosmart Studio, see HP Photosmart Premier (Windows).
2. In the HP Photosmart Studio toolbar, click Share.
3. Click Continue, and follow the instructions on your computer to share the selected

photos with others.
See the onscreen software help for more information about using HP Photosmart Share.
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5 Printing from a computer
To print from a computer, the printer software must be installed. During software
installation, either HP Photosmart Premier (Windows Full-install users), HP Photosmart
Essential (Windows Express-install users) or the HP Photosmart Studio (Mac) is installed
on your computer, allowing you to organize, share, edit, and print photos.
For more information on installing the software, see the Quick Start Guide. Update the
software regularly to ensure you have the latest features and improvements; for
instructions, see Update the software.
To work with photos, you need to transfer them to a computer that is connected to the
printer. See Saving photos to a computer.

Note Windows users: HP Photosmart Premier can only be used on computers
with processors that have Intel® Pentium® III (or equivalent) and higher.

Using creative options in the printer software
Read through these tips on how to open and use HP Photosmart Premier (Windows),
HP Photosmart Essential (Windows), HP Photosmart Studio (Mac), and HP Photosmart
Share.

HP Photosmart Premier (Windows)
HP Photosmart Premier is an easy-to-use software program that gives you everything
you need to have fun with your photos, in addition to basic photo editing and printing.
This software also gives you access to HP Photosmart Share so that you can easily share
your photos. HP Photosmart Premier is only available to Windows users.

Open HP Photosmart Premier (Windows users)
➔ Double-click the HP Photosmart Premier icon on your desktop. If you need help,

see the software help within HP Photosmart Premier.
Explore the many features of HP Photosmart Premier:
● View — View photos in multiple sizes and ways. Easily organize and manage your

photos.
● Edit — Crop your photos and fix photos with red eye. Automatically adjust and

enhance your photos in different sizes and in multiple layouts.
● Print — Print your photos in different sizes and in multiple layouts.
● Share — Send photos to family and friends without the bulky attachments using HP

Photosmart Share, a better way to send e-mail.
● Create — Easily create album pages, cards, calendars, panoramic photos, CD

labels, and more.
● Back-up — Make back-up copies of your photos to store and save.

HP Photosmart Essential (Windows)
HP Photosmart Essential is an easy-to-use software program that gives you basic photo
editing and printing capabilities. This software also gives you access to HP Photosmart
Share so that you can easily share your photos. HP Photosmart Essential is only
available for Windows users.
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Open HP Photosmart Essential (Windows users)
➔ Double-click the HP Photosmart Essential icon on your desktop. If you need help,

see the software help within HP Photosmart Essential.
Explore the many features of HP Photosmart Essential:
● View — View photos in multiple sizes and ways. Easily organize and manage your

photos.
● Edit — Crop your photos and fix photos with red eye. Automatically adjust and

enhance your photos to make them perfect.
● Print — Print your photos in different sizes and in multiple layouts.
● Share — Send photos to family and friends without the bulky attachments with HP

Photosmart Share, a better way to send e-mail.

HP Photosmart Studio (Mac)
➔ Click the HP Photosmart Studio icon in the Dock.
Explore the many features of the HP Photosmart Mac software that is accessible from
the HP Photosmart Studio:
● Import — Import photos or videos from an HP digital camera.
● View and Manage — View, organize, and manage your photos and videos.
● Edit — Adjust and enhance your images.
● Slideshow — Create an online slideshow of your photos.
● Panorama — Create a single panoramic image from several images.
● Create — Create album pages, cards, labels, posters, banners, and more.
● Print — Print your photos and frames from video in standard sizes or in index sheet

format.
● Share — Send photos to family and friends without the bulky attachments.
● Shop — Order online prints and gifts.

HP Photosmart Share
HP Photosmart Share allows you to send photos to family and friends without bulky e-
mail attachments. For more information, see Connecting through HP Photosmart
Share and the HP Photosmart Premier, HP Photosmart Essential, or HP Photosmart Mac
help.

Open HP Photosmart Share (Windows users)
➔ Click the HP Photosmart Share tab within HP Photosmart Premier or

HP Photosmart Essential.

Open HP Photosmart Share (Mac users)
➔ In HP Photosmart Studio, select photos to share, and then click the Share button in

the toolbar.

Set print preferences
Print preferences are set by default, but can be altered to suit your needs. You can set
specific job settings when you print from the computer. When you change settings before
printing, the changes only affect the current print job. In some Windows software
programs, you need to click Properties or Preferences within the Print dialog box to
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access the advanced printing features. See the electronic Help for more information
about printing preferences.

Access print preferences (Windows users)
1. Open the Print dialog box, usually by selecting Print from the File menu.
2. Change the printing preferences in the Print dialog box tabs, or click Properties

or Preferences to access more printing preferences.

Access print preferences (Mac users)
1. Open the Print dialog box, usually by selecting Print from the File menu.
2. Change the printing preferences in the Print dialog box by selecting the print options

you want to change in the Copies & Pages drop-down menu.
For more information on changing the printing preferences, see the electronic Help.

Open the electronic help

Windows users:
● Press F1 on your keyboard.
● For field-level help, click the ? in the top right corner of the Print dialog box.

Mac users:
1. From the Finder, choose Help > Mac Help.
2. Choose HP Photosmart Mac Help from the Library menu, and then choose the

printer name in the HP Photosmart Mac Help table of contents.

HP Real Life technologies features
Explore the many photo editing and enhancing options in the HP Real Life technologies
software features. These features—such as automatic red eye removal and adaptive
lighting—make it easy for you to print high-quality photos.
There are three options available:
● The Basic setting sharpens images and improves the quality and clarity of low

resolution images, such as those downloaded from the Internet.
● The Full setting improves images that are under exposed or over exposed, contain

dark areas or red eye, or have colors that appear washed out.
● The Off setting lets you edit the image manually in a software program such as

HP Photosmart software.

Access Real Life technologies features (Windows users)
1. Open the Print dialog box, usually by selecting Print from the File menu.
2. Click the Paper/Quality tab, then click the Real Life Digital Photography button

—OR— Click the Properties or Preferences button, click the Features tab, and
then choose Basic (the default), Full, or Off from the Photo Fix drop-down menu
in the Real Life Digital Photography area.
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Access Real Life technologies features (Mac users)
1. Open the Print dialog box, usually by selecting Print from the File menu.
2. Select Real Life Digital Photography from the Copies & Pages drop-down menu.
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6 Care and maintenance
The printer requires very little maintenance. Follow the guidelines in this section to extend
the life span of the printer and printing supplies, and to ensure that the photos you print
are always of the highest quality.
● Clean and maintain the printer
● Update the software
● Store and transport the printer and ink cartridges
● Maintain the quality of photo paper

Clean and maintain the printer
Keep the printer and ink cartridges clean and well maintained using the simple
procedures in this section.

Clean the outside of the printer
1. Turn off the printer, then disconnect the power cord from the back of the printer.
2. Wipe the outside of the printer with a soft cloth that has been lightly moistened with

water.

Caution Do not use any type of cleaning solution. Household cleaners and
detergents may damage the printer finish. Do not clean the interior of the printer.
Keep all fluids away from the interior. Do not lubricate the metal rod on which the
print head slides. Noise is normal when the print head moves back and forth.

Aligning the printer
Use the following procedure when the self test report shows streaking or white lines
through any of the blocks of color.
If you still have print quality problems after aligning the printer, try cleaning the print head
using the procedure described in Care and maintenance. If print quality problems persist
after aligning and cleaning, contact HP Customer Support.

If you are using a Windows computer:
1. Load letter or A4 unused plain white paper into the main tray.
2. From the Windows Start menu, select HP > HP Solution Center.
3. Click Settings > Print Settings > Printer Toolbox.
4. Click Align the Printheads.
5. Follow the onscreen instructions.

If you are using a Macintosh:
1. Load letter or A4 unused plain white paper into the main tray.
2. Click HP Device Manager in the Dock.
3. From the Information and Settings pop-up menu, choose Maintain Printer.
4. Click Launch Utility.
5. In the Configuration Settings area of the HP Printer Utility window, click Align.
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Print a sample page
You can print a sample page to test the printer photo printing quality and to make sure
the paper is loaded correctly.

If you are using a Windows computer:
1. Load paper in the main tray. Use plain paper to conserve photo paper.
2. From the Windows Start menu, select HP > HP Solution Center.
3. Click Settings > Print Settings > Printer Toolbox.
4. Click Print a Sample Page and follow the onscreen instructions.

If you are using a Macintosh:
1. Load paper in the main tray. Use plain paper to conserve photo paper.
2. Click HP Device Manager in the Dock.
3. From the Information and Settings pop-up menu, choose Maintain Printer.
4. Click Launch Utility.
5. In the Configuration Settings area of the HP Printer Utility window, click Sample

Page, and then Print Sample Page.

Automatically clean the printhead
If you notice white lines or streaks on the photos you print, or in the color blocks of the
self test report, use this procedure to clean the print head. Do not clean the print head
unnecessarily, as this wastes ink and shortens the life of the ink nozzles on the print
head.

If you are using a Windows computer:
1. Load letter or A4 unused plain white paper into the main tray.
2. From the Windows Start menu, select HP > HP Solution Center.
3. Click Settings > Print Settings > Printer Toolbox.
4. Click Clean the Printheads and follow the onscreen instructions.

If you are using a Macintosh:
1. Load letter or A4 unused plain white paper into the main tray.
2. Click HP Device Manager in the Dock.
3. From the Information and Settings pop-up menu, choose Maintain Printer.
4. Click Launch Utility.
5. In the Configuration Settings area of the HP Printer Utility window, click Clean,

and then click Clean again in the right section of the window.
If print quality still seems poor after you clean the print head, try aligning the printer using
the procedure described in Aligning the printer. If print quality problems persist after
cleaning and aligning, contact HP support.

Manually clean the ink cartridge contacts
Clean the copper-colored ink cartridge contacts if a message appears on the computer
screen that says a cartridge is missing or damaged.
Before cleaning the ink cartridge contacts, remove the ink cartridge and verify that
nothing is covering the ink cartridge contacts or the ink cartridge slot, then reinstall the
ink cartridge. If you continue to get a message that says a cartridge is missing or
damaged, clean the ink cartridge contacts. If you still get this message after cleaning the
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contacts, you will need a replacement ink cartridge. Remove the affected ink cartridge
and look at the end-of-warranty date on the bottom, in YYYY/MMM/DD format. If it is
before the end-of-warranty date, contact HP support to obtain a replacement ink
cartridge.

To clean the ink cartridge contacts:
1. Gather the following items to clean the contacts:

– Distilled, filtered, or bottled water (tap water may contain contaminants that can
damage the ink cartridge)

Caution Do not use platen cleaners or alcohol to clean the ink cartridge
contacts. These can damage the ink cartridge or the HP Photosmart.

– Dry foam rubber swabs, lint-free cloth, or any soft material that will not come
apart or leave fibers.

2. Open the top cover of the printer.
3. Squeeze the gray tab below an ink cartridge slot to release the gray latch inside the

printer, then lift the latch.

Caution Do not remove multiple ink cartridges at the same time. Remove
and clean each ink cartridge one at a time. Do not leave the ink cartridge
outside the printer for more than 30 minutes.

4. Lightly moisten a swab or cloth with water and squeeze out any excess water.
5. Hold the ink cartridge by its handle and gently wipe only the copper-colored contacts

with the swab or cloth.

1 Gently wipe only the copper-colored contacts
6. Place the ink cartridge back into the empty slot and press down on the gray latch

until it clicks into place.
7. Repeat if necessary for the other ink cartridges.
8. Close the top cover.

Caution The ink supply may become pressurized. Inserting a foreign object into
the ink supply could result in ink being expelled and coming in contact with
persons or property.

Print a self test report
If you are experiencing problems with printing, print a self test report. This report can help
you diagnose printing problems and can provide valuable information if you need to call
HP customer support. You can also use this report to check on the approximate
percentage of ink remaining in the ink cartridges.
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If you are using a Windows computer:
1. Load paper in the main tray. Use plain paper to conserve photo paper.
2. From the Windows Start menu, select HP > HP Solution Center.
3. Click Settings > Print Settings > Printer Toolbox.
4. Click Print a Diagnostic Page and follow the onscreen instructions.

If you are using a Macintosh:
1. Load letter or A4 unused plain white paper into the main tray.
2. Click HP Device Manager in the Dock.
3. From the Information and Settings pop-up menu, choose Maintain Printer.
4. Click Launch Utility.
5. In the Configuration Settings area of the HP Printer Utility window, click Test, and

then click Print Test Page in the right section of the window.
The HP Photosmart prints a two-page self test report that contains the following
information:
● Product information: Includes the model number, serial number, and other product

information.
● Revision information: Includes the firmware version number and indicates whether

or not you have an HP two-sided printing accessory (duplexer) installed.
● Ink delivery system information: Displays the approximate ink level of each

installed ink cartridge, the status of each ink cartridge, the date each cartridge was
installed, and the expiration date for each cartridge.

● Print head assembly information: Contains information that may be used for
diagnostic purposes if you need to call HP customer support.

● Print head parameters: Contains information that may be used for diagnostic
purposes if you need to call HP customer support.

● Print quality pattern: Displays six color blocks, representing each of the six
installed cartridges. When streaks appear through the color blocks, or there are
missing color blocks, clean the print head using the procedure described in Care
and maintenance. If the color blocks still show print quality problems after cleaning
the print head, align the printer using the procedure described in Aligning the
printer. If the color blocks continue to show print quality problems after cleaning and
aligning, contact HP support.

● History log: Contains information that may be used for diagnostic purposes if you
need to call HP customer support.
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Self test report

Update the software
Download the latest printer software update periodically to ensure you have the latest
features and improvements. You can download printer software updates by going to
www.hp.com/support or by using HP Software Update.

Note The printer software update that you download from the HP web site does
not update the HP Photosmart Premier software.

Downloading the software (Windows)

Note Make sure you are connected to the Internet before you use HP Software
Update.

1. From the Windows Start menu, select Programs (in Windows XP, select All
Programs) > Hewlett-Packard > HP Software Update. The HP Software Update
window opens.

2. Click Check Now. HP Software Update searches the HP web site for printer
software updates. If the computer does not have the most recent version of the
printer software installed, a software update appears in the HP Software Update
window.

Note If the computer has the most recent version of the printer software
installed, the following message appears in the HP Software Update window:
“No updates are available for your system at this time”.

3. If a software update is available, click the checkbox next to the software update to
select it.

4. Click Install.
5. Follow the onscreen instructions to complete the installation.
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Downloading the software (Mac)

Note Make sure you are connected to the Internet before you use
HP Photosmart Updater.

1. From the Finder, choose Go > Applications.
2. Choose Hewlett-Packard > Photosmart > HP Photosmart Updater.
3. Follow the onscreen instructions to check for software updates.

If you are behind a firewall, you need to enter the proxy server information in the
updater.

Store and transport the printer and ink cartridges
Protect the printer and ink cartridges by storing them properly when you are not using
them.

Store and transport the printer
The printer is built to withstand long or short periods of inactivity. Store the printer indoors
out of direct sunlight in a place without temperature extremes.

Caution To prevent ink loss or spillage: do not transport or store the printer on
its side, and leave the ink cartridges installed while storing and transporting the
printer.

Store and transport the ink cartridges
When you transport or store the printer, always leave the active ink cartridge inside the
printer to prevent the ink from drying out.

Caution 1 To prevent ink loss or spillage: leave the ink cartridges installed while
storing and transporting the printer, and avoid leaving used ink cartridge(s) out of
the printer for extended lengths of time.

Caution 2 Make sure the printer completes its power-down cycle before you
unplug the power cord. This allows the printer to store the print head properly.

Follow this tip to help maintain your HP ink cartridges and ensure consistent print quality:
Keep all unused ink cartridges in their original sealed packages until they are needed.
Store ink cartridges at room temperature (15-35 °C or 59-95 °F).

Maintain the quality of photo paper
For best results with photo paper, follow the guidelines in this section.

To store photo paper
● Store the photo paper in its original packaging or in a resealable plastic bag.
● Store the packaged photo paper on a flat, cool, and dry surface.
● Return unused photo paper to the plastic bag. Paper left in the printer or exposed

to the elements may curl.
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To handle photo paper
● Always hold photo paper by the edges to avoid fingerprints.
● If the photo paper has curled edges, place it in its plastic storage bag and gently

bend it in the opposite direction of the curl until the paper lies flat.
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7 Troubleshooting
The HP Photosmart printer is designed to be reliable and easy to use. This chapter
answers frequently asked questions about using the printer and printing without a
computer. It contains information about the following topics:
● Printer hardware problems
● Printing problems
● Error messages
For additional troubleshooting information, see:
● Software installation troubleshooting: The Quick Start guide that came with the

printer.
● Printer software and printing from a computer troubleshooting: The onscreen

HP Photosmart Printer Help. For information about viewing the onscreen
HP Photosmart Printer Help, see Welcome.

Printer hardware problems
Before contacting HP support, read this section for troubleshooting tips or go to the online
support services at www.hp.com/support.

Note If you want to connect the printer to a computer with a USB cable, HP
recommends using a 2.0 high-speed compliant cable 3 meters (10 feet) or less
in length.

The On light is flashing but the printer is not printing
Solution The printer is busy processing information; wait for it to finish.

The printer is plugged in but will not turn on

Solution
● The printer may have drawn too much power. Unplug the printer power cord.

Wait about 10 seconds, then plug the cord back in. Turn on the printer.
● The printer may be plugged into a power strip that is turned off. Turn on the

power strip, then turn on the printer.
● The power cord could be defective. Make sure the green light on the power cord

is lit.

The printer makes noises when I turn it on, or starts making noises after sitting
unused for a while

Solution The printer may make noises after long periods of inactivity
(approximately 2 weeks), when its power supply has been interrupted and then
restored, or when ink cartridges have been replaced. This is normal operation. The
printer is performing an automatic maintenance procedure to ensure it produces the
best quality output.
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All the lights are flashing on the printer
Solution The printer has encountered a hardware error and may need to be
serviced. Unplug the power cord to the printer. Wait about 10 seconds, and then
plug it in again. Turn on the printer. If the lights are still flashing, please go to
www.hp.com/support, or contact HP Support for help.

Printing problems
Before contacting HP support, read this section for troubleshooting tips or go to the online
support services at www.hp.com/support.

The printer does not print borderless photos when I print from a digital camera
Solution Make sure you have photo paper in the photo tray. The printer only uses
media from the photo tray (not main tray) when printing from a digital camera.

Printing is very slow
Solution You may have one of the following situations: 1) you may be printing a
PDF or a project containing high-resolution graphics or photos or 2) you may have
selected the highest resolution for your printout. Large, complex projects containing
graphics or photos print slower than text documents, especially at higher resolutions.

Paper does not feed into the printer correctly from the main tray

Solution
● There may be too much paper loaded in the tray. Remove some paper and try

printing again.
● The main tray may not be pushed in all the way. Push the main tray all the way

in.
● The paper guides may not be adjusted correctly. Make sure the paper-width

and paper-length guides fit close to the edges of the paper without bending the
paper.

● Two or more pieces of paper may be sticking together. Remove the paper from
the main tray, fan the edges of the stack to separate the sheets of paper, then
reload the paper and try printing again.

● If the paper is wrinkled or bent, try using different paper.
● The paper may be too thin or too thick. Use HP inkjet paper for best results. For

more information, see Choose the right paper.

Printed pages are dropping off of the output tray
Solution Always extend the output tray extension when you print.
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Print jobs using the photo tray do not print
Solution The photo tray may not be properly engaged in the printer. Lift the output
tray up and verify that the photo tray is pushed in until it stops and then lower the
output tray. Press Resume.

The printout is rippled or curled
Solution The project you are printing uses a larger amount of ink than normal.
Print the project from a computer, and use the printer software to lower the ink
saturation level. See the onscreen HP Photosmart help for more information.

The document printed at an angle or is off-center

Solution
● The paper may not be loaded correctly. Reload the paper, making sure it is

correctly oriented in the main tray and that the paper-width and paper-length
guides fit close to the edges of the paper. For paper-loading instructions, see
Paper loading tips.

● If you are using a two-sided printing accessory, try removing it and printing
again.

● The printer may need to be aligned. For more information, see Aligning the
printer.

Colors are not printing satisfactorily

Solution
● The printer may need to be aligned. For more information, see Aligning the

printer.
● The print head may need to be cleaned. For more information, see Care and

maintenance.

No page came out of the printer or the paper jammed while printing

Solution
● The printer may need attention. If the printer is connected to a computer, check

the computer screen for instructions.
● The power may be off or there may be a loose connection. Make sure the power

is on and the power cord is securely connected.
● You may not have any paper in the main tray or photo tray. Check that the paper

is loaded correctly. For paper-loading instructions, see Paper loading tips.
● If the paper jammed while printing, try the following:

– Turn off the printer, then unplug it from the power source. Clear the printer
of any paper obstructing the paper path. Remove the rear access door.
Gently remove the jammed paper from the printer, then replace the rear
access door. If all jammed paper cannot be removed from the rear area of
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the printer, try removing paper jammed in the middle of the printer by
opening the paper jam door located inside the top cover. For illustrations
of the two places to clear a paper jam, see Paper errors. When you are
finished clearing the paper jam, plug the printer back in, turn it on, and try
printing again.

– If you were printing labels, make sure a label did not become unglued from
the label sheet while going through the printer.

A blank page came out of the printer

Solution
● You may have begun printing and then cancelled the print job.

If you cancelled the print job before printing started, the printer may have already
loaded paper in preparation for printing. The next time you print, the printer
ejects the blank page before starting the new printing project.

● A print job with a large amount of data may have been sent to the printer.
Wait for the printer to service the print head before it continues printing.

The photo did not print using the default print settings
Solution You may have changed the print settings for the photo. Print settings you
apply to an individual photo on a camera override the default print settings. Discard
all print settings that have been applied to an individual photo by deselecting the
photo on the camera. For more information, see the documentation that came with
the camera.

The printer ejects the paper when preparing to print
Solution Direct sunlight could be interfering with the operation of the automatic
paper sensor. Move the printer out of direct sunlight.

Print quality is poor

Solution
● Use photo paper designed for the printer. For best results, use the papers

recommended in Choose the right paper.
● You may be printing on the wrong side of the paper. Make sure the paper is

loaded with the side to be printed facing down.
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● You may have selected a low-resolution setting on the digital camera. Reduce
the size of the image and try printing again. For better results in the future, set
the digital camera to a higher photo resolution.

● There may be a problem with the print head. Try the following:
– Run the automatic print head cleaning procedure. For more information,

see Care and maintenance.
– Align the printer. For more information, see Aligning the printer.
– If print quality problems persist after you have tried all of the above

solutions, contact HP Support.

Photos are not printing correctly

Solution
● You may have loaded the photo paper incorrectly. Load the photo paper with

the side to be printed facing down.
● The photo paper may not have fed into the printer correctly. Try the following:

– Check for a paper jam. For more information, see Paper errors.
– Insert the photo paper as far as it will go into the photo tray.
– Load one sheet of photo paper at a time.

The photos I marked for printing in the digital camera do not print
Solution Some digital cameras let you mark photos for printing in both the
camera's internal memory and on the memory card. If you mark photos in the internal
memory, and then move photos from the camera's internal memory to the memory
card, the marks do not transfer. Mark photos for printing after you transfer them from
the digital camera's internal memory to the memory card.

I plugged a camera into the printer, but nothing happens
Solution Try the following:
● Make sure the camera is connected to the camera port on the front of the printer.

The rear USB port does not support digital cameras.
● Make sure the camera is a PictBridge digital camera set to PictBridge mode or

is an HP direct-printing camera. The printer only supports these two types of
cameras.

● Check the camera batteries. Replace if necessary.
● Restart the camera.

Error messages
Before contacting HP support, read this section for troubleshooting tips or go to the online
support services at www.hp.com/support.
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If the printer is connected to a computer, the following types of error messages can
appear on the computer screen:
● Paper errors
● Ink cartridge errors
● Memory card or camera errors
● Computer printing errors
If the printer is not connected to a printer, check the indicator lights:

On Resume Ink
indicator

Comments

Solid
green

Blinking Off This sequence of lights often indicates a paper-
related printer problem, such as a paper jam, no
paper, or paper stall. For more information,
see Paper errors. There might also be a
connectivity problem, such as a digital camera
being disconnected during a print job. For more
information, see Computer and connectivity
printing errors.

Blinking Blinking Off There is a carriage stall. For more information,
see Error message: The carriage is stalled..

Solid
green

Off Blinking There is an ink cartridge problem, such as an
empty, damaged, or incorrect cartridge. For
more information, see Ink cartridge errors.

Blinking Blinking Blinking A hardware problem has occurred. For more
information, see All the lights are flashing on the
printer.

Paper errors
Before contacting HP support, read this section for troubleshooting tips or go to the online
support services at www.hp.com/support.

Error message: Paper Jam.
Solution Turn off the printer, then unplug it from the power source. Clear the
printer of any paper that may be obstructing the paper path. Remove the rear access
door. Gently remove the jammed paper from the printer, then replace the rear access
door. Press Resume to continue printing.

1 Remove the rear access door to clear paper jams.
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If you cannot remove all jammed paper from the rear area of the printer, try removing
paper jammed in the middle of the printer by opening the paper jam door located
inside the top cover.

1 Open the paper jam door to clear paper jams in the middle of the printer.

Plug the printer back in and turn it on.

Error message: The printer is out of paper.
Solution Load paper, then press Resume to print again. For paper-loading
instructions, see Paper loading tips.

Error message: Unsupported media size.
Solution The printer cannot use the size of paper loaded in the paper tray.
Press Resume, then load a supported paper size instead. For a list of supported
paper sizes, see Printer specifications.

Error message: Automatic paper sensor failed.
Solution The automatic paper sensor is obstructed or damaged. Try moving the
printer out of direct sunlight, then press Resume and try printing again. If this does
not work, go to www.hp.com/support or contact HP Support.

Ink cartridge errors
Before contacting HP support, read this section for troubleshooting tips or go to the online
support services at www.hp.com/support.

Error message: Incorrect Ink Cartridge(s).
Solution The first time you set up and use your HP Photosmart, make sure to
install the ink cartridges that were shipped with your printer. The ink in these ink
cartridges is specially formulated to mix with the ink in the print head assembly.
To resolve this error, replace the affected ink cartridge(s) with the ink cartridges that
were shipped with your HP Photosmart.
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The indicated ink cartridge(s) cannot be used after the device has undergone
initialization. Replace the ink cartridge(s) with the appropriate ink cartridges for your
HP Photosmart. The cartridge numbers you can use with this printer appear on the
back cover of this printed guide.
For more information on replacing ink cartridges, see Insert ink cartridges.

Error message: Replace Cartridge(s) Soon.
Solution The indicated ink cartridge(s) are low on ink.
You might be able to continue printing for a short period of time with ink remaining
in the print head assembly. Replace the indicated ink cartridge(s) or press
Resume to continue.
For more information on replacing ink cartridges, see Insert ink cartridges.

Error message: Ink Cartridge(s) Empty.
Solution Replace the indicated ink cartridge(s) with new ink cartridge(s).
● If the black ink cartridge is empty, you can continue printing with the other color

ink cartridges by following the onscreen instructions.
● If a color ink cartridge is empty, you can continue printing with the black ink

cartridge by following the onscreen instructions.
Depending on the status of your print job, you can press Resume to continue. If the
HP Photosmart is in the middle of a print job, press Cancel and restart your print
job.

Note Text and photo quality will differ from those printed when using all ink
cartridges. If the empty ink cartridge(s) are not replaced soon, all printing will
stop.

For more information on replacing ink cartridges, see Insert ink cartridges.

Error message: Cannot Print.
Solution The indicated ink cartridge(s) are out of ink.
Replace the indicated ink cartridge(s) immediately so that you can resume printing.
The HP Photosmart cannot continue printing until the indicated ink cartridge(s) are
replaced. All printing will stop.
For more information on replacing ink cartridges, see Insert ink cartridges.

Error message: Ink Cartridge(s) Problem.
Solution The indicated ink cartridge(s) are missing or damaged.
Replace the indicated ink cartridge(s) immediately so that you can resume printing.
If there are no ink cartridges missing from the HP Photosmart, the ink cartridge
contacts might need to be cleaned.
For more information on replacing ink cartridges, see Insert ink cartridges. For more
information on cleaning the ink cartridge contacts, see Care and maintenance.
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If there are no ink cartridges missing from the HP Photosmart, and you still receive
this message after cleaning the ink cartridge contacts, you will need a replacement
ink cartridge. Remove the affected ink cartridge and look at the end-of-warranty date
on the bottom, in YYYY/MMM/DD format. If it is before the end-of-warranty date,
contact HP Support to obtain a replacement ink cartridge.

Error message: Ink Expiration Nearly Expired. —OR— Ink Cartridge(s) Expired.
Solution Each ink cartridge has an expiration date. The purpose of expiration is
to protect the printing system and to ensure ink quality. When you receive an ink
expiration message, remove and replace the ink cartridge, and then close the
message. You can also continue printing without replacing the ink cartridge, by
following the instructions on your computer screen. HP recommends replacing the
expired ink cartridges. HP cannot guarantee the quality or reliability of expired ink
cartridges. Device service or repairs required as a result of using expired ink will not
be covered under warranty.
For more information on replacing ink cartridges, see Insert ink cartridges.

Error message: Non-HP Ink Cartridge(s).
Solution Replace the indicated ink cartridge(s) or press Resume to continue
HP recommends that you use genuine HP ink cartridges. Genuine HP ink cartridges
are designed and tested with HP printers to help you easily produce great results,
time after time.

Note HP cannot guarantee the quality or reliability of non-HP ink. Printer
service or repairs required as a result of printer failure or damage attributable
to the use of non-HP ink will not be covered under warranty.

If you believe you purchased genuine HP ink cartridge(s), go to:
www.hp.com/go/anticounterfeit

Error message: Original HP Ink Depleted.
Solution Replace the indicated ink cartridge(s) or press Resume to continue.
HP recommends that you use genuine HP ink cartridges. Genuine HP ink cartridges
are designed and tested with HP printers to help you easily produce great results,
time after time.

Note HP cannot guarantee the quality or reliability of non-HP ink. Printer
service or repairs required as a result of printer failure or damage attributable
to the use of non-HP ink will not be covered under warranty.

If you believe you purchased genuine HP ink cartridge(s), go to:
www.hp.com/go/anticounterfeit

Error message: The carriage is stalled.
Solution Remove any objects that are blocking the print head assembly.
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To clear the print head assembly
1. Open the top cover, then open the paper jam door.

1 Open the paper jam door to clear the print head assembly.
2. Remove any objects that are blocking the print head assembly, including paper

and any packing materials.
3. Turn the printer off, then turn it on again.
4. Close the paper jam door and the top cover.

Error message: Ink System Failure.
Solution The print head assembly or the ink delivery system has failed and the
HP Photosmart can no longer print.
Turn off the printer, then unplug its power cord. Wait about 10 seconds, then plug it
in again. If this does not clear the error message, please contact HP Support.

Memory card or camera errors
Before contacting HP support, read this section for troubleshooting tips or go to the online
support services at www.hp.com/support.

Error message: Camera is not supported or not in PictBridge mode. Refer to User
Guide.

Solution The HP Photosmart only supports digital cameras in PictBridge mode or
HP directing printing cameras. If you have a PictBridge camera, make sure it is set
to PictBridge mode. For more information, see the documentation that came with
the camera.
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Error message: Cannot print photos.
Solution More than 10 photos specified for a print job may be corrupted, missing,
or are an unsupported file type. For information about supported file types, see
Printer specifications.
● Save the photos to the computer using the digital camera rather than the

memory card.
● Save the files to the computer and print from the computer.

Error message: Camera selections (DPOF) file has error.
Solution The printer is unable to read a DPOF file due to corrupted data or an
error on the memory card. Use the camera to reselect the photos.

Error message: Some camera-selected photos are not on card.
Solution Some camera-selected photos are missing or have been deleted. Try
the following:
● Confirm that you did not accidentally delete the photo from the memory card.
● Reselect the photos again using the digital camera.

Computer and connectivity printing errors
Before contacting HP Support, read this section for troubleshooting tips or go to the online
support services at www.hp.com/support.

Error message: Printer memory is full. Job was cancelled. Press OK.
Solution The printer encountered a problem when printing photos. Try the
following:
● To clear the printer memory, turn the printer off, then turn it on again.
● Print fewer photos at a time.
● Save the photos to the computer and print from there.
● Save the files to the computer using a memory card reader and then print from

the computer.

Error message: HP Photosmart Disconnected!
Solution The printer cannot communicate properly with the computer. The printer
software may not be working or a cable may be loose. Make sure the USB cable is
securely attached to both the computer and to the USB port on the back of the printer.
If the cable is secure, verify that the printer software is installed.
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Error message: Camera is not responding. Check camera connections, batteries,
or restart camera. Refer to User Guide.

Solution The print job will be cancelled. Reattach the USB cable to the camera
and printer and resend the print job.
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8 HP Support
Note The name of HP support services may vary by country/region.

If you have a problem, follow these steps:
1. Check the documentation that came with the printer.
2. If you are unable to solve the problem using the information in the documentation,

visit www.hp.com/support to do the following:
– Access online support pages
– Send HP an e-mail message for answers to your questions
– Connect with an HP technician by using online chat
– Check for software updates
Support options and availability vary by product, country/region, and language.

3. If you are unable to solve the problem using the onscreen Help or HP web sites, call
HP Support using the number for your country/region. For a list of country/region
phone numbers, see HP Support by phone.

HP Support by phone
While the printer is under warranty, you can obtain free phone support. For more
information, see the warranty included in the box, or go to www.hp.com/support to check
the duration of your free support.
After the free phone support period, you can obtain help from HP at an additional cost.
Contact your HP dealer or call the support phone number for your country/region for
support options.
To receive HP support by phone, call the appropriate support phone number for your
location. Standard phone company charges apply.
North America: Call 1-800-474-6836 (1-800–HP-invent). U.S. phone support is
available in both English and Spanish languages 24 hours a day, 7 days a week (days
and hours of support may change without notice). This service is free during the warranty
period. A fee may apply outside the warranty period.
Western Europe: Customers in Austria, Belgium, Denmark, Spain, France, Germany,
Ireland, Italy, Netherlands, Norway, Portugal, Finland, Sweden, Switzerland, and the
United Kingdom should go to www.hp.com/support to access phone support numbers in
their country/region.
Other countries/regions: See the list of support telephone numbers inside the front
cover of this guide.

Placing a call
Call HP Support while you are near the computer and printer. Be prepared to provide the
following information:
● Printer model number (located on the front of the printer)
● Printer serial number (located on the bottom of the printer)
● Computer operating system
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● Version of printer software:
– Windows PC: To see the printer software version, right-click the HP Digital

Imaging Monitor icon in the Windows taskbar and select About.
– Macintosh: To see the printer software version, use the Print dialog box.

● Messages displayed on the computer monitor
● Answers to the following questions:

– Has the situation you are calling about happened before? Can you recreate the
situation?

– Did you install any new hardware or software on the computer around the time
that the situation occurred?

Return to HP repair service (North America only)
HP will arrange to have your product picked up and delivered to an HP Central Repair
Center. We pay for the round-trip shipping and handling. This service is free for the
duration of the hardware warranty period.

HP Quick Exchange Service (Japan only)

Additional warranty options
Extended service plans are available for the printer at additional costs. Go to
www.hp.com/support, select your country/region and language, then explore the
services and warranty area for information about the extended service plans.
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A Specifications
This section lists the minimum system requirements for installation of the HP Photosmart printer
software, and provides selected printer specifications.
For a complete list of printer specifications and system requirements, see the onscreen HP
Photosmart help. For information about viewing the onscreen HP Photosmart help, see Welcome.

System requirements

Component Windows PC minimum Macintosh minimum

Operating system Microsoft® Windows 98, 2000
Professional, Me, XP Home,
and XP Professional

Mac® OS X 10.3, 10.4, and
later

Processor Intel® Pentium® II (or
equivalent) and higher

G3 or greater

RAM 64 MB (128 MB
recommended)

Mac OS X 10.3, 10.4, and
later: 128 MB

Free disk space 500 MB 150 MB

Video display 800 x 600, 16-bit or higher 800 x 600, 16-bit or higher

CD-ROM drive 4x 4x

Connectivity USB: Microsoft Windows 98,
2000 Professional, Me, XP
Home, and XP Professional
PictBridge: using front
camera port
Bluetooth: using optional
HP Bluetooth Wireless
Adapter

USB: Front and back ports
(Mac OS X 10.3, 10.4, and
later)
PictBridge: using front
camera port
Bluetooth: using optional
HP Bluetooth Wireless
Adapter

Browser Microsoft Internet Explorer 5.5
or later

—

Printer specifications

Category Specifications

Image file formats JPEG Baseline
TIFF 24-bit RGB uncompressed interleaved
TIFF 24-bit YCbCr uncompressed interleaved
TIFF 24-bit RGB packbits interleaved
TIFF 8-bit gray uncompressed/packbits
TIFF 8-bit palette color uncompressed/packbits
TIFF 1-bit uncompressed/packbits/1D Huffman
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Category Specifications

Video file formats Motion-JPEG AVI
Motion-JPEG QuickTime
MPEG-1

Media specifications Recommended maximum length: 61 cm (24 inch)
Recommended maximum paper thickness: 292 µm
(11.5 mil)
Recommended maximum envelope thickness: 673 µm
(26.5 mil)

Media sizes supported Supported sizes when printing from a computer
7.6 x 12.7 cm to 22 x 61 cm (3 x 5 inch to 8.5 x 24 inch)
Supported sizes when printing from a digital camera
attached to the camera port
Metric: 10 x 15 cm (with and without tab), A6; Imperial:
3.5 x 5 inch, 4 x 6 inch (with and without tab); Other: Hagaki

Media types supported Paper (plain, inkjet, photo, and panoramic photo)
Envelopes
Transparencies
Labels
Cards: index, greeting, Hagaki, A6, L-size
Iron-on transfers
Avery C6611 and C6612 photo sticker paper: 10 x 15 cm
(4 x 6 inch), 16 rectangular or oval stickers per page
HP CD/DVD Tattoos (not available in all countries/regions)

Paper tray – media sizes
supported

Main tray
8 x 13 cm to 22 x 61 cm (3 x 5 inch to 8.5 x 24 inch)
Photo tray
Up to 10 x 15 cm (4 x 6 inch), with or without tab
Output tray
All supported main tray and photo tray sizes

Paper tray capacity Main tray
100 sheets of plain paper
14 envelopes
20–40 cards (depending on thickness)
30 sheets of labels
25 transparencies, iron-on transfers, or photo paper
10 sheets of photo paper
Photo tray
20 sheets of photo paper
50 sheets of plain paper
10 cards or envelopes
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Category Specifications
25 sheets of labels or iron-on transfers

Operating environment Recommended temperature range: 15–30 °C (59-86 °F)
Maximum temperature range: 5–40 °C (41-104 °F)
Storage temperature range: -40–60 °C (-40-140 °F)
Recommended humidity range: 20–80% RH
Maximum humidity range: 10–80% RH

Physical specifications Height: 17.29 cm (6.81 inch).
Width: 46.25 cm (18.21 inch)
Depth: 38.73 cm (15.25 inch)
Weight: 7.37 kg (16.2 lb).

Power consumption Printing, Maximum: 59 W
Idle: 10–12 W
Off mode: Less than 1 W

Power supply model number HP Part # 0957-2105

Power requirement 100–240 VAC (± 10%), 50–60 Hz (± 3 Hz)

Ink cartridges HP Yellow Ink Cartridge
HP Cyan Ink Cartridge
HP Light Cyan Ink Cartridge
HP Magenta Ink Cartridge
HP Light Magenta Ink Cartridge
HP Black Ink Cartridge

Note The cartridge numbers you can use with this
printer appear on the back cover of this printed
guide. If you have already used the printer several
times, you can also find the cartridge numbers in
the printer software. For more information, see
Insert ink cartridges.

Print speed (maximum) Black printouts: 32 pages per minute
Color printouts: 31 pages per minute
Photos: 14 seconds for each 10 x 15 cm (4 x 6 inch) photo

USB support Microsoft Windows 98, 2000 Professional, Me, XP Home,
and XP Professional
Mac OS X 10.3, 10.4, and later
HP recommends using a USB 2.0 full-speed compliant
cable 3 meters (10 feet) or less in length.

(continued)
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B HP Warranty
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A. Extent of limited warranty
 1. Hewlett-Packard (HP) warrants to the end-user customer that the HP products specified above will be free from 

defects in materials and workmanship for the duration specified above, which duration begins on the date of purchase 
by the customer.

 2. For software products, HP's limited warranty applies only to a failure to execute programming instructions. HP does 
not warrant that the operation of any product will be interrupted or error free.

 3. HP's limited warranty covers only those defects that arise as a result of normal use of the product, and does not cover 
any other problems, including those that arise as a result of:

  a. Improper maintenance or modification;
  b. Software, media, parts, or supplies not provided or supported by HP;
  c. Operation outside the product's specifications;
  d. Unauthorized modification or misuse.
 4. For HP printer products, the use of a non-HP cartridge or a refilled cartridge does not affect either the warranty to the 

customer or any HP support contract with the customer. However, if printer failure or damage is attributable to the use 
of a non-HP or refilled ink cartridge, HP will charge its standard time and materials charges to service the printer for 
the particular failure or damage.

 5. If HP receives, during the applicable warranty period, notice of a defect in any product which is covered by HP's 
warranty, HP shall either repair or replace the product, at HP's option.

 6. If HP is unable to repair or replace, as applicable, a defective product which is covered by HP's warranty, HP shall, 
within a reasonable time after being notified of the defect, refund the purchase price for the product.

 7. HP shall have no obligation to repair, replace, or refund until the customer returns the defective product to HP.
 8. Any replacement product may be either new or like-new, provided that it has functionality at least equal to that of the 

product being replaced.
 9. HP products may contain remanufactured parts, components, or materials equivalent to new in performance.

  10. HP's Limited Warranty Statement is valid in any country where the covered HP product is distributed by HP. Contracts 
for additional warranty services, such as on-site service, may be available from any authorized HP service facility in 
countries where the product is distributed by HP or by an authorized importer.

B. Limitations of warranty
TO THE EXTENT ALLOWED BY LOCAL LAW, NEITHER HP NOR ITS THIRD PARTY SUPPLIERS MAKES ANY 
OTHER WARRANTY OR CONDITION OF ANY KIND, WHETHER EXPRESS OR IMPLIED WARRANTIES OR 
CONDITIONS OF MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR 
PURPOSE.

C. Limitations of liability
 1. To the extent allowed by local law, the remedies provided in this Warranty Statement are the customer's sole and 

exclusive remedies.
 2. TO THE EXTENT ALLOWED BY LOCAL LAW, EXCEPT FOR THE OBLIGATIONS SPECIFICALLY SET FORTH IN 

THIS WARRANTY STATEMENT, IN NO EVENT SHALL HP OR ITS THIRD PARTY SUPPLIERS BE LIABLE FOR 
DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, WHETHER BASED ON 
CONTRACT, TORT, OR ANY OTHER LEGAL THEORY AND WHETHER ADVISED OF THE POSSIBILITY OF 

   SUCH DAMAGES.
D.  Local law

 1. This Warranty Statement gives the customer specific legal rights. The customer may also have other rights which vary 
from state to state in the United States, from province to province in Canada, and from country to country elsewhere 
in the world.

 2. To the extent that this Warranty Statement is inconsistent with local law, this Warranty Statement shall be deemed 
modified to be consistent with such local law. Under such local law, certain disclaimers and limitations of this Warranty 
Statement may not apply to the customer. For example, some states in the United States, as well as some 
governments outside the United States (including provinces in Canada), may:

  a. Preclude the disclaimers and limitations in this Warranty Statement from limiting the statutory rights of a consumer 
   (e.g., the United Kingdom);
  b. Otherwise restrict the ability of a manufacturer to enforce such disclaimers or limitations; or
  c. Grant the customer additional warranty rights, specify the duration of implied warranties which the manufacturer 

HP product Duration of limited warranty
Software Media 90 days
Printer 1 year
Print or Ink cartridges  Until the HP ink is depleted or the “end of warranty” date printed 
 on the cartridge has been reached, whichever occurs first. This 

warranty does not cover HP ink products that have been refilled, 
remanufactured, refurbished, misused, or tampered with.

Accessories 90 days
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Index

A
accessories 8
accessories, two-sided

printing 9
aligning the printer 25
alignment page 25

B
Bluetooth

connecting to printer 17,
19

wireless printer adapter 9
buttons 8

C
cameras

connecting to printer 17,
19

direct-printing 17
PictBridge 17
port 6
printing from 17

care and maintenance 25
cartridges. See ink cartridges
cleaning

copper-colored contacts
26

print head 26
printer 25

computer
connecting to printer 19
printing from 21
saving photos to 20
system requirements 47

control panel 8

D
damaged, ink cartridge 40
digital camera

saving photos to a
computer 20

digital cameras. See cameras
documentation, printer 5

E
e-mailing photos 20
energy consumption 2

Energy Star 2
error messages 37

F
file formats, supported 47
Frequently asked questions

33

G
Getting help 33

H
Help 33
Hewlett-Packard Company

notices 2
HP direct-printing digital

cameras 17
HP Instant Share 19
HP Photosmart Essential 21
HP Photosmart Premier 21
HP Photosmart Share 20, 22
HP Photosmart Studio (Mac

only) 22
HP Software Update 29
HP Support 45

I
ink

checking level 27
empty 40
replace soon 40

ink cartridges
damaged 40
empty 40
expired 41
HP ink depleted 41
incorrect 39
ink level, checking 15
inserting 15
missing 40
non-HP ink 41
replace soon 40
replacing 15
storing 30
testing 27

ink level, checking 15
inserting

ink cartridges 15

L
lights 8
Load paper 11

M
Macintosh

HP Photosmart Mac
software 22

main tray
loading 11

missing ink cartridge 40

P
Paper

load 11
paper

buying and choosing 11
maintaining 11, 30
specifications 47
trays 6

photo tray
loading 12

photos
e-mailing 20
printing 17
saving to computer 19

Photosmart Share. See
HP Photosmart Share

PictBridge cameras 17
print head

cleaning 26
failure 42
stalled 41

Printer
Specifications 47

printer
accessories 8
care and maintenance 25
cleaning 25
connecting 17, 19
documentation 5
error messages 37
parts 6
specifications 47
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storing 30
printer software

updating 29
printer software, updating 21
printing

from a computer 21
from BlueTooth device 17
from cameras 17
from memory cards 17
from PictBridge camera

17
photos 17
test page 27
without computer 17

Q
quality

photo paper 30
printing test page 27

Questions and Answers 33

R
regulatory notices

regulatory model
identification number 2

replacing ink cartridges 15

S
saving photos to computer 19
Specifications 47
storing

ink cartridges 30
photo paper 30
printer 30

system requirements 47

T
test page 27
transporting printer 8
trays, paper 6
Troubleshooting 33
troubleshooting

error messages 37
HP Support 45

two-sided printing 9

U
USB

connection type 19
port 6
specifications 47
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